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Trademarks

This product incorporates copyright protection technology that is
protected by method claims of certain U.S. patents and other intel-
lectual property rights owned by Macrovision Corporation and other
rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home or
other limited viewing uses only unless otherwise authorized by Mac-
rovision Corporation. Reverse engineering or disassembly is prohib-
ited.

Intel and Pentium are registered trademarks of Intel Corporation.
Windows is a registered trademark of Microsoft Corporation.



Federal Communications Commission (FCC)

Statement

This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or televi-
sion reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

» Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

» Consult the service representative or an experienced radio/TV techni-
cian for help.
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Warning

Use only shielded ca-
bles to connect I/O de-
vices to this
equipment.

You are cautioned that
changes or modifica-
tions not expressly ap-
proved 0} the
manufacturer for com-
pliance with the above
standards could void
your authority to oper-
ate the equipment.
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IMPORTANT SAFETY INSTRUCTIONS

When using your telephone equipment, basic safety precautions
should always be followed to reduce the risk of fire, electric shock
and injury to persons, including the following:

1.

Do not use this product near water, for example near a bath
tub, wash bowl, kitchen sink or laundry tub, in a wet basement
or near a swimming pool.

Avoid using a telephone (other than a cordless type) during an
electrical storm. There may be a remote risk of electrical shock
from lightning.

Do not use the telephone to report a gas leak in the vicinity of
the leak.

Use only the power cord and batteries indicated in this manual.
Do not dispose of batteries in a fire. They may explode. Check
with local codes for possible special disposal instructions.

CAUTION

Always disconnect all telephone lines from the wall outlet before
servicing or disassembling this equipment.

USE THE APPROPRIATE 26AGW TELEPHONE LINE
CORD



IMPORTANTES MESURES DE SECURITE

Certaines mesures de sécurité doivent étre prises pendant I'utilisa-
tion de matérial téléphonique afin de réduire les risques d’incendie,
de choc ¢lectrique et de blessures. En voici quelquesunes:

1.

Ne pas utiliser 'appareil prés de I'eau,, p.ex., prés d’une baignoire,
d’un lavabo, d’'un évier de cuisine, d’'un bac a laver, dans un sous-sol
humide ou prés d’une piscine.

Eviter d'utiliser le téléphone (sauf s'il s’agit d’un appareil sans fil) pen-
dant un orage électrique. Ceci peut présenter un risque de choc élec-
trique causé par la foudre.

Ne pas utiliser I'appareil téléphonique pour signaler une fuite de gaz
s’il est situé pres de la fuite.

Utiliser seulement le cordon d’alimentation et le type de piles indiqués
dans ce manuel. Ne pas jeter les piles dans le feu: elles peuvent
exploser. Se conformer aux réglements pertinents quant a I'émination
des piles.

ATTENTION

Débranchez toujours toutes les lignes téléphoniques des prises mu-
rales avant de réparer ou de démonter cet équipement.

UTILISEZ LE CORDON DE TELEPHONE 26AGW
APPROPRIE
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Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To
ensure that does not happen, follow these suggestions:

1. Don’t drop it. Make sure it's on a stable surface. If the compu-
ter falls, the case and other components could be damaged. Do
not expose it to any shock or vibration.

2. Don’t overheat it. Keep the computer and power supply away
%" from any kind of heating element. Keep the computer out of
N\, /(f@ direct sunlight. Don’t store or use the computer in a humid envi-
. @ ® ronment. Do not place the computer on any surface which will
block the vents.

3. Avoid interference. Keep the computer away from high capac-
ity transformers, electric motors, and other strong magnetic

fields. These can hinder proper performance and damage your
& data.
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4. Keep it dry. This is an electrical appliance. If water or any other
liquid gets into it, the computer could be badly damaged. Do
not leave it in a place where foreign matter or moisture may
affect the system.

Vi
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5. Follow the proper working procedures for computer. Shut-
down the computer properly, and close all programs (don’t for-
get to save your work). Do not turn off any peripheral devices
when the computer is on. Do not disassemble the computer by
yourself. Remember to periodically save your data as data may
be lost if the battery is depleted. Perform routine maintenance
on your computer.

6. Take care when using peripheral devices. Use only

approved brands of peripheral devices. Unplug the power cord - » 5

before attaching any peripheral device. %&@V&
7. Do not place anything heavy on the computer.
c;ﬁ g@
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Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

*  Your AC adapter may be designed for international travel but it still
requires a steady, uninterrupted power supply. If you are unsure of your
local power specifications, consult your service representative or local
power company.

* The power adapter may have either a 2-prong or a 3-prong grounded
plug. The third prong is an important safety feature; do not defeat its
purpose. If you do not have access to a compatible outlet, have a quali-
fied electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by
the plug head, not by its wire.

* Make sure the socket and any extension cord(s) you use can support
the total current load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any
external power supplies (i.e. AC adapter or car adapter).

* Do not plug in the power cord if you are wet.

* Do not use the power cord if it is broken.

* Do not place heavy objects on the power cord.



Battery Precautions

*  Only use batteries designed for this computer. The wrong battery type
may explode, leak or damage the computer.

» Recharge the batteries using the notebook’s system. Incorrect recharg-
ing may make the battery explode.

* Do not try to repair a battery pack. Refer any battery pack repair or
replacement to your service representative or qualified service person-
nel.

» Keep children away from, and promptly dispose of a damaged battery.
Always dispose of batteries carefully. Batteries may explode or leak if
exposed to fire, or improperly handled or discarded

* Keep the battery away from metal appliances.

* Affix tape to the battery contacts before disposing of the battery.

* Do not touch the battery contacts with your hands or metal objects.

N\
I

Caution

Danger of explosion if battery is incorrectly replaced. Replace only with the

same or equivalent type recommended by the manufacturer. Discard used
battery according to the manufacturer’s instructions.
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Battery Disposal

The product that you
have purchased con-
tains a rechargeable
battery. The battery is
recyclable. At the end
of its useful life, under
various state and local
laws, it may be illegal
to dispose of this bat-
tery into the municipal
waste stream. Check
with your local solid
waste officials for de-
tails in your area for re-
cycling options or
proper disposal.
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Cleaning

Do not apply cleaner directly to the computer, use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any
part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may vio-
late your warranty and expose you and the computer to electric
shock. Refer all servicing to authorized service personnel. Unplug
the computer from the power supply. Then refer servicing to quali-
fied service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

+ If the computer has been exposed to rain or other liquids.

» If'the computer does not work normally when you follow the operating
instructions.

* If the computer has been dropped or damaged (do not touch the poison-
ous liquid if the LCD panel breaks).

+ If'there is an unusual odor, heat or smoke coming from your computer.



Preface

Travel Considerations

Packing

As you get ready for your trip, run through this list to make sure the
system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it’s latched.

Disconnect the AC adapter and cables. Stow them in the carry-

ing bag.

The AC adapter uses voltages from 100 to 240 volts so you

won’t need a second voltage adapter. However, check with

your travel agent to see if you need any socket adapters.

6. Putthe notebook in its carrying bag and secure it with the bag’s
straps.

7. If you're taking any peripherals (e.g. a printer, mouse or digital
camera), pack them and those devices’ adapters and/or
cables.

8. Anticipate customs - Some jurisdictions may have import

restrictions or require proof of ownership for both hardware and

software. Make sure your “papers” are handy (it may be useful
to have the computer in standby mode before going through
customs).

PON~
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On the Road

In addition to the general safety and maintenance suggestions in this
preface, and see Appendix A:“Troubleshooting’ . Keep these points
in mind:

Hand-carry the notebook.
For security, don’t let it out of your sight. In some areas, computer
theft is very common.

Don’t check it with “normal” luggage. Baggage handlers may not be
sufficiently careful. Avoid knocking the computer against hard ob-
jects.

Beware of Electromagnetic fields.

Metal detectors & X-ray machines

These devices can damage the computer, hard disk, floppy disks, LS-
120 disks and other media. They may also destroy any stored data -
Pass your computer and disks around the devices. Ask security offi-
cials to hand-inspect them. (You may be asked to turn it on.)

Note: Some airports also scan luggage with these devices.



Fly safely.

Most airlines have regulations about the use of computers and other
electronic devices in flight. These restrictions are for your safety, fol-
low them. If you stow the notebook in an overhead compartment,
make sure it’s secure. Contents may shift and/or fall out when the
compartment is opened.

Get power where you can.
If an electrical outlet is available, use the AC adapter and keep your
battery(ies) charged.

Keep it dry.

If you move quickly from a cold to a warm location, water vapor can
condense inside the computer. Wait a few minutes before turning it
on so that any moisture can evaporate.
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Developing Good Work Habits

Developing good work habits is important if you need to work in
front of the computer for long periods of time. Improper work habits
can result in discomfort or serious injury from repetitive strain to
your hands, wrists or other joints. The following are some tips to re-
duce the strain:

* Adjust the height of the chair and/or desk so that the keyboard is at or
slightly below the level of your elbow. Keep your forearms, wrists, and
hands in a relaxed position.

*  Your knees should be slightly higher than your hips. Place your feet
flat on the floor or on a footrest if necessary.

* Use a chair with a back and adjust it to support your lower back com-
fortably.

+ Sit straight so that your knees, hips and elbows form approximately 90-
degree angles when you are working.

» Take periodic breaks if you are using the
computer for long periods of time.




Remember to:

» Alter your posture frequently.

» Stretch and exercise your body several times a day.

» Take periodic breaks when you work at the computer for long periods
of time. Frequent and short breaks are better than fewer and longer
breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce
eye strain and muscle fatigue in your neck and shoulders.

» Position the display to avoid glare or reflections from overhead light-
ing or outside sources of light.

» Keep the display screen clean and set the brightness and contrast to
levels that allow you to see the screen clearly.

* Position the display directly in front of you at a comfortable viewing
distance.

* Adjust the display viewing angle to find the best position.
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Chapter 1: Introduction

Overview

What this chapter covers:

* The Manual — how to use it

*  Quick Start Guide — the minimum you need to know

* System Map — navigating around your computer

. |
Overview 1 - 1
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4

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features.

1 - 2 The Manual

The Manual

This manual refers to the hardware and essential software required to
run your notebook computer. Depending on how your system is con-
figured, some or all of the features described may already be set up.

Advanced Users

If you are an advanced user you may skip over most of this manual.
However you may find it useful to refer to the “Drivers & Utilities”
on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The
Computer” on page 6 - 1. You may also find the notes marked with
a /2 of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers, or do not have an advanced knowledge
of them, then you should try to look through all the documentation.
Do not worry if you do not understand everything the first time. Keep
this manual nearby and refer to it to learn as you go. You may find it
useful to refer to the notes marked with a / as indicated in the mar-
gin.
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Warning Boxes

No matter what your level please pay careful attention to the warning
and safety information indicated by the 2.)& symbol. Also please note
the safety and handling instructions as indicated in the Preface.

Not Included

Operating Systems (e.g. Windows 98 Second Edition, Window ME,
Windows 2000 Professional, Windows XP etc.) have their own man-
uals as do applications (e.g. word processing, spreadsheet and data-
base programs). If you have questions about the operating systems or
programs then please consult the appropriate manuals.

System Software

Your computer may already come with system software pre-in-
stalled. Where this is not the case, or where you are re-configuring
your computer for a different system, you will find this manual refers
to the following operating systems:

*  Microsoft Windows 98SE

*  Microsoft Windows ME - Millennium Edition
*  Microsoft Windows 2000

*  Microsoft Windows XP

The Manual 1 - 3
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Quick Start Guide

/ This guide assumes that you are already familiar with computers and

Peripheral Devices can tell at a glance what and where all the key components are. If you

Flesse e e 5 are not that comfortable with this type of device, then please refer to
ripherals (printers, dig- the following pages, which give an overview of the system.

ital cameras, etc.)

which attach to your £ ¢ jq otj]] best to review these steps, before taking any action. If there
computer by either

USB or IEEE1394 is anything you are not sure about, then please refer to the appropri-
ports may be connect- ate chapter before continuing.

ed after Windows is up

and running. All other . .
B Unless you need to install an operating system, your computer

connected before you should be ready to work right out of the box. Before you begin please
turn on the system. follow the safety instructions in the Preface.

1. Remove all packing materials, CDs/DVDs, floppy disks, and any PC
Cards.

2. Securely attach any peripherals you want to use with the notebook
(e.g. keyboard and mouse) to their ports.

3. Attach the AC adapter to the DC-in jack on the left of the computer
(see “Left Side View” on page 1 - 17). Then plug the AC power cord
into an outlet, and connect the AC power cord to the AC adapter.

4. Raise the lid/LCD to a comfortable viewing angle.

5. Press the power button to turn “on”.

1 - 4 Quick Start Guide
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System Map e

Y our notebook PC has a lot of built-in features. Most of these are en-

abled by your operating system. Further explanations of the various Design Differences

subsystems are covered in the chapter or pages indicated. ‘i rerE] e
. the two notebook de-

Getting To Know Your Computer signs pictured on this

The following graphics will help you to become familiar with the ba- page.

sic functions, and to learn the location of the various ports and com- o eehis e

ponents of your computer. slightly in external de-

sign. Photographs
used throughout this
manual are of Design .

Figure I -1
Design
Differences

Design | sig Il

SystemMap 1 - 5
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Model Types

In addition to the two external designs mentioned on page 1-5, this
notebook series includes three model types according to their speci-
fications (a total of six different combinations). Table I - 1 on
page 1-8 will help you identify your model type:

CPU Type

All the model types support a range of different CPUs and you can
check the Appendix (Appendix A:“Processor (Model A)” on
page A-1) for the full details on CPU types. Only Model B supports
mobile processors (see “Mobile CPU” on page 3 - 17), and requires
the installation of the Intel SpeedStep driver for Win 98SE, Win
ME, and Win 2000 (Win XP does not require the SpeedStep driver).

Video Card

There are two video card types as indicated in Table I - 1 on page 1-
8. You can identify the video card by going to the Display Properties
control panel (see “Advanced Display Properties” on page 3 - 5)
and checking under “Display:”, after you have installed the video
driver (it is the same driver for both video card types).

1 - 6 Model Types
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USB Port Type

For full details on the USB ports see “Four USB Ports” on page 1 -
24. Only Model C supports USB 2.0 and requires the driver be in-
stalled (see “- Install Procedure” on page 4 - 4). You may identify
if your system is Model C by checking the video card type as out-
lined in “Video Card” on page I - 6. If the card is a MOBILITY
RADEON 9000, then the machine is Model C and requires the USB
2.0 driver installation.

.|
Model Types 1 - 7
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Table I - 1
Model Differences

1 - 8 Model Types

Feature Model A Model B Model C
Intel Pen-
Intel Pentium® 4 - Intel Mobile t'zug"/g*);(s'/zzf/
CPUs 1.4/1.5/1.6/1.7/ Pentium® 4 - 1.4/ 2-5/2.53/2.6/
Supported 1.8/2.0/2.2/ 1.5/1.6/1.7/1.8/ 2 66 GH.z
2.4GHz 2.0GHz )
Intel Celeron
1.7 & 1.8 GHz
Video Card | ATI Radeon 7500 | ATI Radeon 7500 | 1! 9%%%90“
2.0 (install
USB Port 11 11 drivers - see
Type ' ' Table 4-1o0n
page 4-4)
e
gzee(:)Srtt:S No Table 4 - 1 on No
PP page 4-4)

*Windows XP does not require Intel SpeedStep driver installation.
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Top View with LCD Panel Closed

Figure I -2
Top View with LCD
Panel Closed

1. LCD Latch
2. LED Power &
E-Mail Indicators

Design | Design I

To open the LCD display:

Place the computer on a stable surface.

Move the cover latch @ to the right to release the top cover.
Lift the top cover to reveal the LCD panel and keyboard.
Adjust the LCD panel to a comfortable viewing angle.

The LED Power & E-Mail indicators @ show the power source
and power status of the computer, and give notification of
e-mail received.

aObRhwN =

Top View with LCD Panel Closed 1 - 9
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Figure I -3

Top View with LCD

N —

o0k

© o~

10.

Panel Open

LCD

LED Power &
E-Mail Indicators
Close Cover
Switch
Speakers
Hot-Key buttons
LED Status
Indicators
Power Button
Keyboard
TouchPad and
Buttons

Palm Rest
(Removable)

Top View with LCD Panel Open

1 - 10 Top View with LCD Panel Open
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LCD Panel

The notebook PC comes with a 14.1" or 15" TFT LCD (Liquid Crys-
tal Display) screen depending upon the configuration purchased (see
page A -3 for full details).

LED Power & Auto Mail Indicators C

(
These indicators display the current power source and power status D/o
of the computer. The third indicator may be configured to give a vi-
sual confirmation when e-mail is received in the default e-mail pro-
gram (see “Auto Mail Checker” on page 2 - 8).

Close Cover Switch

This switch acts as a sensor to tell when the LCD Panel is closed.
When this LCD cover sensor is activated the default setting of your
operating system’s power scheme sends the computer into a power
saving state (see “Advanced Power Options” on page 3 - 23).

Stereo Speakers
Two built-in speakers provide rich, stereo sound.

Top View with LCD Panel Open 1 - 11
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Hot-Key Buttons
(@ (.W) The three hot-keys allow you instant access to your default Internet

browser, default e-mail program, and an application of your choice.
To learn how to set the buttons see “Hot-Keys” on page 2 - 19.

(-] —~ ¢ LED Status Indicators
U @ These display the system’s operational status. Refer to “LED Status

Indicators” on page 2 - 11 for more information on what the lights
mean.

.|
1 - 12 Top View with LCD Panel Open
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Power Button O)

Press this button to turn your computer on or off (see “Turning on
the Computer” on page 2 - 5). This button may also be used as a
suspend/resume key, once configured as such in the power /
management control panel of your operating system (see

“Configuring the Power Button” on page 3 - 23). Shatta

Please note that you
should always shut
your computer down
by choosing the Shut

d

Forced Off Down/Turn Off Com-

puter command from
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn't
work, press the power button for 4 seconds to force the system to turn
itself off.

Keyboard

The computer has a “Win Key” keyboard with an embedded numeric
keypad. It has the same features as a full-sized desktop keyboard and
can easily be replaced with a different language keyboard should you
desire.

Top View with LCD Panel Open 1 - 13
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TouchPad & Buttons

The pointing device features a sensitive glide pad for precise move-
ments. It functions the same way as a two-button mouse. The right
TouchPad button is the same as the right mouse button; the left
TouchPad button is the same as the left mouse button. The central
buttons may be used to scroll up and down, or they may be config-
ured to perform a variety of function (see “Configuring the Touch-
Pad and Buttons” on page 2 - 26).

Removable Palm Rest

Depending upon the configuration you purchased, this can be ex-
changed.

1 - 14 Top View with LCD Panel Open
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Figure I -4
Front View

Front View

—_—

LCD Latch

2. Audio “DJ” CD
Player Control
Panel On/Off
Switch
Previous Track
Next Track
LCD

Play Pause
Stop

Volume Down
Volume Up

0. Built-In
Microphone

Audio “DJ” CD Player

The built-in standalone audio CD player gives you direct hardware
control for audio CDs when the computer is shut down, but has a
working power source.

SORNOO AW

If the computer is running then control for all CDs is handed over to
the Operating System’s software controller, however the CD Play-
er’s volume controls can still be used to set the audio volume.

. |
Front View 1 - 15
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Note: If you are playing a CD in the audio player you will not be
able to use the power button to switch the computer on. Switch
the CD audio player OFF first, then press the power button to turn
on the computer.

4

Sound Volume Adjustment

How high the sound volume can be set using the volume control knob de-
pends on the setting of the volume control within Windows. Click the
Speaker icon on the taskbar to check the setting.

The Volume controls on the Audio DJ player still control the volume set-
tings if the computer’s operating system is running.

All peripherals must be connected before you turn on the system.

(7 Microphone
Record on your notebook computer with the built-in microphone.

1 - 16 Front View
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Figure I -5
Left Side View

Left Side View

DC-In Jack
Vent

PC Card Slot
PC Card Eject
Button

BN =

DC-In Jack
Plug the supplied AC adapter into this jack to power your notebook.

PC Card Slot 2 &

This is a Type-II PC card slot (also previously referred to as PCM-
CIA). Refer to “The PC Card Slot” on page 2 - 18 for more infor-
mation on the PC Card slot.

Overheating

To prevent your com-

puter from overheating
make sure nothing
Vent blocks the vent/fan
outlets while the com-

This enables airflow to prevent the notebook from overheating. puter is in use

. |
Left Side View 1 - 17
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Figure I -6
Right Side View

Right Side View

1. Device Bay One
2. Device Bay Two .
3 Infrared Device Bays One & Two

Transceiver There are two storage bays on your notebook computer:

Bay One will have ONE of the following interchangeable devices,
depending on the configuration purchased:
* 3.5" 3-mode FDD

DVD-ROM

CD-ROM

CD-RW and DVD-ROM Combo drive

CD-RW

Secondary battery pack

Bay Two will have ONE of the following fixed CD devices, depend-

ing on the configuration purchased:
DVD-ROM
CD-ROM
CD-RW and DVD-ROM Combo drive
CD-RW

|
1 - 18 Right Side View
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3.5" FDD (Floppy Disk Drive)

If your computer has the floppy disk option, itis a 3.5, 3-mode, 1.44 ﬁ
MB fixed floppy disk drive. For more information please refer to

“The Floppy Disk Drive (FDD)” on page 2 - 13. Media Warning

Don’t try to remove a

floppy disk while the
system is accessing it.
This may cause the
system to “crash”.

|
Right Side View 1 - 19
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CD Device

7£l< A 5.25” CD-ROM drive, or DVD-ROM drive, or CD-RW, or Com-

CD Emergency Eject bination CD-RW and DVD-ROM Drive (12.7mm height) is standard

in Bay 2 depending on the model you purchased. There may also be

:efjiztj gegcé)t/%rcgm(’:gy another CD device in Bay 1. For more information on using the drive
el please refer to “The CD/DVD Device” on page 2 - 14.

power interruption) you
may push the end of a
straightened paper clip

into the Emergency
eject hole.

Do not use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

CD-ROM or DVD label to indicate which type
Busy Indicator

Open button

Emergency eject hole

hON=

Figure I -7
CD Device

1 - 20 Right Side View
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Infrared Transceiver

The infrared transceiver enables communication between the com- /

puter and another similarly equipped device, and is 115.2k SIR, 4M Infrared

bps FIR, IrDA 1.1 compliant (see “Configuring the Infrared Set- Communication
tings for FIR” on page 3 -31). qu further information, please refer N
to the manual of the device you wish to connect. er operates on a “Line

of Sight”.

Make sure nothing is
blocking the “Line of
Sight” between your
system’s transceiver
and the destination’s
transceiver.

Right Side View 1 - 21
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Figure I -8
Rear View

Rear View

R =06_-00C

Security Lock 1 ST o .r
Microphone-In LLLCOLRES = i
Jack

3. Headphone-Out
Jack

S/PDIF Out Port
Mini - IEEE 1394
Port Overheating

4 USB Ports To prevent your computer from overheating make sure nothing blocks the
RJ-11 Phone vent while the computer is in use.
Jack

8. RJ-45 LAN Jack

9. S-Video
Connector

10. External Moni-
tor (CRT) Port

11. Parallel Port

12. PS/2 Type Port

13. Vents

N —

ok

N o

1 - 22 Rear View
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Security Lock 33

To prevent possible theft, a Kensington-type lock can be attached to
this slot. Locks can be purchased at any computer store.

Microphone-In Jack

Record on your notebook computer with an external microphone.

ﬁ%
Headphone-Out Jack ( )

Headphones or speakers may be connected through this jack.
Note: Set your system’s volume to a reduced level before connecting
to this jack.

S/PDIF Out Port

You can use this port for S/PDIF (Sony/Philips Digital Interface For-
mat) output, which allows you to connect your DVD-capable PC to
a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Rear View 1 - 23
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Mini - IEEE 1394 Port

IEEE1394 This allows high speed connection to various peripheral devices, e.g.
external disk drives and digital cameras (see note below).

4

IEEE 1394
The IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

o> Four USB Ports

These USB ports are hardware interfaces for USB compliant periph-
erals, such as external HDDs, digital video cameras, scanners, a key-
board, a mouse, joysticks, printers and telephony devices.
Depending upon the configuration purchased, your USB ports may
be either USB 1.1 OR USB 2.0 compliant. Only Model C has USB
2.0 compliant USB ports (see “USB Port Type” on page 1 - 7).
High speed USB devices are usually only USB 2.0 compliant (check
the documentation which comes with your USB compliant peripher-
al). Devices may be plugged into the computer, and unplugged from
the computer, without the need to turn the system off.

1 - 24 Rear View



RJ-11 Phone Jack

This port connects to the built-in modem. You may plug the tele-
phone line directly into this RJ-11 telephone connection.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN
port.

RJ-45 LAN Jack
This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN
port.

S-Video Connector

Connect your television to your computer and view DVDs, VCDs or
anything else your computer can display. You will need an S-Video
cable to make the connection. Enable this port from the video driver
controls (see “Enabling TV Display” on page 3 - 15).

External Monitor (CRT) Port

Connect an external CRT monitor to this port to allow dual video or
simultaneous display on the LCD and external CRT monitor (see
“Display Devices” on page 3 - 7).

Introduction a

i
B

Rear View 1 - 25
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Ej Printer/Parallel Port
This port supports ECP (Extended Capabilities Port) and EPP (En-

hanced Parallel Port) 1.7/1.9 modes.

B/ PS/2 Type Port

Connect an external PS/2 type mouse or keyboard to this port. You
can use a “Y” splitter if you want to attach both.

. |
1 - 26 Rear View
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Figure I - 9
Bottom View

Bottom View

Vent/Fan Outlets
Device Bay One
Device Bay One
Release Latch
Device Bay Two
Battery

Battery Release
Latch

>N
/ﬂ\

Overheating

Wn =

ook~

To prevent your com-
puter from overheating

make sure nothing
blocks the vent/fan
outlets while the com-
puter is in use.

Bottom View 1 - 27
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Wireless Network Card

Your computer may have an optional 802.11b Wireless Networking
solution. If included, the antennae and other components are not ex-
ternally visible (please check with your service representative). If
your configuration includes the Wireless Network module, make
sure you install the driver (see “What to Install” on page 4 - 2).

1 - 28 Wireless Network Card
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Chapter 2: Using The Computer a

Overview

To learn more about your computer’s features, please read this chap-
ter.

This chapter includes:

» The Power Sources

* Turning on the Computer
» LED Indicators

e The Hard Disk Drive

» The Floppy Disk Drive

» The CD/DVD Device

* The PC Card Slot

+ Keyboard

» TouchPad & Buttons

* Mouse

* Printer (general guidelines)

. |
Overview 2 - 1
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e

Shutdown

Always shut your com-

puter down by the
Shut Down/Turn Off
Computer command
from the Start menu in
Windows.

Figure 2 - 1
AC Adapter

2 - 2 The Power Sources

The Power Sources

The computer can be powered by either an AC adapter or a battery
pack.

AC Adapter

Use only the AC adapter that comes with your computer. The wrong
type of AC adapter will damage the computer and its components.

1.

2.

o

Attach the AC adapter to the DC-in jack on the left of the com-
puter.

Plug the AC power cord into an outlet, then connect the AC
power cord to the AC adapter.

Raise the lid/LCD to a comfortable viewing angle.

Press the power button to turn “on”.




Battery
The battery allows you to use your notebook computer while you are
on the road or an electrical outlet is unavailable. Battery life varies
depending on the applications and the configuration you're using. To
increase battery life, let the battery discharge completely before re-
charging.

We recommend leaving the battery inside the notebook at all times.
For more information on the battery, please refer to “Battery Infor-
mation” on page 3 - 24.

Using The Computer

4

Battery Release

Hold the battery re-
lease latch @) in the
“unlocked” position

and it will pop-up for
removal (see “Remov-
ing and Replacing
the Battery” on
page 3 - 27).

Figure 2 - 2
Battery Removal

The Power Sources 2 - 3
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The battery pack automatically recharges when the AC adapter is at-
tached and plugged into an electrical outlet. If the computer is pow-
ered on, and in use, it will take several hours to fully recharge the
battery. When the computer is turned off but plugged into an electri-
cal outlet, battery charge time is less (see “LED Indicators” on
page 2 - 6 for information on the battery charge status).

b Recharging the Battery with the AC Adapter

Proper handling of the Battery Pack

* DO NOT disassemble the battery pack under any circumstances.

* DO NOT expose the battery to fire or high temperatures, it may
explode.

* DO NOT connect the metal terminals (+, -) to each other. (For more
information on how to maintain the battery pack, refer to “Battery
Information” on page 3 - 24.)

. |
2 - 4 The Power Sources



Turning on the Computer

Now you are ready to begin using your computer. To turn it on sim-
ply press the power button on the front panel.

When the computer is on, you can use the power button as a hot-key
button when it is pressed for less than 4 seconds. Use Power Man-
agement or Power Options in the “Windows” Control Panel to con-
figure this feature.

4

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work,
press the power button for 4 seconds, or longer, to force the system to turn
itself off.

.|
Turning on the Computer 2 - 5

Using The Computer

4

Power Button as
Standby or Hibernate
Button

If you are using a fully
ACPIl-compliant  OS,
(such as Windows ME,
Windows 2000 Profes-
sional, or Windows XP)
you can use the OS’s

“Power Options” con-
trol panel to set the
power button to send
the system into Stand-
by or Hibernate mode
(see “Advanced Pow-
er Options” on
page 3 - 23 for details).
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LED Indicators

There are two sets of LED indicators (LED Power & Auto Mail In-
dicators and LED Status Indicators) on your computer that will
display helpful information about the current status of the computer.

/OCa &
Figure 2 - 3

LED Indicators

The LED Power & Auto Mail Indicators are also visible when the top
of your computer is closed.

. |
2 - 6 LED Indicators



LED Power & Auto Mail Indicators

Blinking Green

Icon Color Description
Yellow AC Power is plugged in
Green The computer is on
DD P

The system is in the configured standby
mode

Yellow The battery is being charged
Green The battery is fully charged
Blinking Yellow The battery has reached critically low

power status

Blinking Green

New mail has arrived

New mail has arrived from users defined

Fast Blinking in the Special Group in the Auto Mail
Green
Checker
Orange The secondary* battery is being charged
Green The secondary* battery is fully charged

Using The Computer

MANZ
1%

Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC
adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.

*Note: The secondary
battery is optional, de-
pending upon the con-
figuration purchased.

Table 2 - 1
LED Power &
Automail
Indicators

LED Indicators 2 - 7
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b Auto Mail Checker

After you have installed the driver for the Auto Mail program (see
“What to Install” on page 4 - 2) you may then configure it to give
you notification when you receive new mail. You must be online to
receive this notification (note that this program only supports the
POP3 protocol), and your default mail program does not need to be
open.

The Auto Mail Checker appears as anicon ¢ in the taskbar. Click-
ing on the icon will bring up the following options menu.

Check Mail
Skart

Exit

Select Open to bring up the control panel for the program.

2 - 8 Auto Mail Checker
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Y ou may then configure the options for your mailserver, name, pass-

word, program and method(s) of notification. /
5 Note
e (G| Check with your Inter-
@ net Service Provider,
Mail Received——— Afl
Host | network administrator
Pat [110 or Mail Service provid-
User D | 0000 er for details on what to
U put on these pages.

Mail Checking Interval

I3 j minuteslD j seconds &l M

Figure 2 - 4
Auto Mail
Auto Mail Checker = Checker Account
Eonnectiona’AccountI Special Group Setup and
Options

Optia Setting
¥ Enable Mail LED
v Enable Natification Sound

v Enable Mokfication Message IDutIDok Express

Mame of kail Program

Auto Mail Checker 2 - 9
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Special Group

You may also define the users you want to appear in this group (see
Figure 2 - 5). If you choose to enable the Mail LED then the [
icon will flash when you receive new mail in your default mail pro-
gram.

F igu}’ e 2 -5 Auto Mail Checker
Special Group Connectionddccount |2
Setup

Add

111@a2

Remove

i

Remaove &l

You may add the e-mail addresses of those you wish to assign to your
special group here. The LED will then blink fast when mail is re-
ceived from members of this group, if LED notification is enabled in
the control panel (Figure 2 - 4).

. |
2 - 10 Auto Mail Checker



LED Status Indicators

Once your computer is on and in use, the LED status indicators will
display the system's operational status.

Using The Computer

Scroll Lock

To enable and disable
the Scroll Lock feature,

press the Fn and

Scroll Lock is activated

Icon Color Description ScrLk keys simultane-
ously.
% Green Floppy/Hard disk/CD Device activity
IEI Green Number Lock is activated Table 2 - 2
LED Status
Green Caps Lock is activated Indicators
Green

LED Status Indicators 2 - 11
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ZRS
Power Safety

Before attempting to
access any of the inter-
nal components of

your notebook please
ensure that the com-
puter is not connected
to the AC power, and
that it is turned off.

Figure2 -6
Hard Disk
Location

The Hard Disk Drive

The hard disk drive is used to store your data in the notebook com-
puter. It is mounted in a removable case and can be taken out to ac-
commodate other 2.5 IDE hard disk drives with a height of 9.5 mm.
See “Storage” on page A-5.

The hard disk is accessible from the bottom of your computer under
the device installed in Bay One as seen below ). Further details on
removing and inserting the hard disk are available in “Upgrading the
Hard Disk Drive” on page 6 - 5.

2 - 12 The Hard Disk Drive



The Floppy Disk Drive (FDD)

The computer may be equipped with a fixed 1.44 MB, 3.5” floppy
disk drive module depending on the configuration purchased. By de-
fault it is drive “A:” and can be used as a boot device if properly set
in the BIOS (refer to “Boot Menu” on page 5 - 18).

Inserting/Removing Floppy Disks

When using the floppy drive, always insert your floppy diskette with
the label-side facing up. To remove the inserted diskette, press the
eject button on the top-right corner of the floppy drive.

Using The Computer

R
PG
Media Warning

Don’t try to remove a
floppy disk while the

system is accessing it.
This may cause the
computer to “crash”
and damage your data.

Figure 2 -7
Floppy Disk
Drive

The Floppy Disk Drive (FDD) 2 - 13
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4

Sound Volume
Adjustment

How high the sound
volume can be set us-
ing the volume control
knob depends on the
setting of the volume
control within  Win-
dows. Click the
Speaker icon on the
taskbar to check the
setting.

The Volume controls
on the Audio DJ player
still control the volume
settings if the compu-
ter's operating system
is running.

All peripherals must be
connected before you
turn on the system.

The CD/DVD Device

There are two bays for a combination of a CD-ROM, or DVD-ROM,
or CD-RW, or Combination CD-RW and DVD-ROM drive depend-
ing on the model you purchased (you may alternatively have a floppy
disk drive or secondary battery in one bay). The CD Device is usual-
ly labeled drive D: and may be used as a boot device if properly set
in the BIOS (“Boot Menu” on page 5 - 18).

Loading Compact Discs

To insert a CD/DVD disc, press the open Button and carefully place
a CD/DVD disc onto the disc tray with label-side facing up (use just
enough force for the disc to click onto the tray’s spindle). Gently
push the CD/DVD tray in until its lock “clicks” and you are ready to
start. The Busy Indicator will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unex-
pectedly interrupted, insert an object such as a straightened paper
clip into the emergency eject hole to open the tray.

2 - 14 The CD/DVD Device
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Handling CDs or DVDs

\ A/
Proper handling of your CDs/DVDs will prevent them from being 7&(
damaged. Please follow the advice below to make sure that the data
stored on your CD-ROM / DVD-ROM discs can be accessed.

Media Warning

When manually eject-
Remember to: ing a CD/DVD disc,
DO NOT use a sharp-
* Hold the CD or DVD by the edges; do not touch the surface of the disc. ened pencil or similar

+ Use a clean, soft, dry cloth to remove dust or fingerprints. object which, may
* Do not write on the surface with a pen. lbrgak i ,anﬁ hblecome
* Do not attach paper or other materials to the surface of the disc. odged in the hole.

* Do not store or place the CD or DVD in high-temperature areas.

¢ Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
* Do not bend the CD or DVD.

* Do not drop or subject the CD or DVD to shock.

2N\
2 &

CD Emergency Eject

If you need to manually eject a CD (e.g. due to an unexpected power in-

terruption) you may push the end of a straightened paper clip into the
emergency eject hole. However please do not use a sharpened pencil or
similar object that may break and become lodged in the hole.

The CD/DVD Device 2 - 15
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Al DVD Regional Codes

’Q\ DVD region detection is device dependent, not OS-dependent. You
WinDVD Player Note can select your module’s region code 5 times. The fifth selection is
T B permanent. This cannot be altered even if you change your operating

supports CPU speeds system or you use the module in another computer.
up to, and including,

2.4GB only.
y Properties | DWD Region | Vulumes|
A A Mozt VD' are encoded for play in specific regions. To plap a
WInDVD version 4'0 regionalized DVD on your computer, pou must sst your LD drive to
SUppOrtS a” CPU Eﬁgﬂ:;s‘lirtnm that region by selecting a geographic area from the

speeds.

CAUTIOMN *You can change the region a limited number of times,
After Changes remaining reaches zero, you cannot change the region even
if you reinztall wWindows or move your DVD drive to a different computer

Make sure you are us-
ing the program ver-
sion applicable to your

Changes remaining: 3

To change the current region, select a geographic area, and then click OK.

CPU speed. See lgharitan 5
Algeria
ez Samas
for further details on b a
CPU speeds. CutertRegor: Fegonz
Mew Region: li
Figure 2 - 8
DVD Regional
Codes
(Windows XP)

2 - 16 The CD/DVD Device



Changing DVD Regional Codes

Go to the Control Panel in WindowsXP/Windows 2000 and double-
click System, click Device Manager, then click the + next to DVD/
CD-ROM drives. Double-click on the DVD-ROM device to bring
up the Properties menu, and select the DVD Region (tab) to bring
up the control panel as seen in “DVD Regional Codes (Windows
XP)” on page 2 - 16.

DVD Regional Coding

Region Geographical Location
1 USA, Canada
2 Western Europe, Japan, South Africa, Middle East & Egypt
3 South-East Asia, Taiwan, South Korea, The Philippines,

Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, New Zealand
5 N Korea, Russia, Eastern Europe, India & Most of Africa
6 China

Using The Computer

4

Changing Region
Codes in Windows
98/ME

If you are using Win-
dows 98 or Windows
ME then you will need
to use your DVD player
software to change the
regional code.

Table 2 - 3
DVD Regional
Coding

The CD/DVD Device 2 - 17
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The PC Card Slot

/Zl\ The computer is equipped with a type II PCMCIA 3.3V/5V socket

The PC Card Problem which supports CardBus. The PC Card slot @ is on the left of the
in Windows 98SE

computer.
See
Inserting and Removing PC Cards

» Align the PC Card with the slot and push the Card in until it locks into
place.

 To remove a PC Card, simply press the eject button @ next to the slot.

information.

Figure 2 -9
The PC Card Slot

2 &
The PC Card Problem
in Windows ME

See

information.

2 - 18 The PC Card Slot
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Hot-Keys a

The computer has two sets of Hot-Keys, three Hot-Key buttons on
the computer, and the function key combinations on the keyboard.

Figure 2 - 10
o © © Hot-Keys
& o
- W W

Hot-Key Buttons

These keys access the Internet @), e-mail @ or a user-defined appli-
cation @ with one quick button press. To use the “user-defined Hot-
Key”, you must install the hot-key driver. Refer to “What to Install”
on page 4 - 2 for driver installation steps.

Hot-Keys 2 - 19
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n ~ Programming the Hot-Keys

Non-Default E-Mail

and Browser Hot-Key | Function
Programs
It is possible to config- . .
ure both the efmail and @ Activate the default e-mail program.

browser hot-keys to
open non-default mail

and browser ~pro- (WD Activate the default Internet browser.

grams. Follow the pro-
cedure outlined on
page 2-21 but high-
light either the Brows- Activate the user specified application e.g Microsoft

er or Email in step 2. Word or Excel.
Choose Custom to
browse to the program

of your choice as per | After installing the Hot-Key driver (see “What to Install” on page 4

the remaining instruc- .
e, T Hsilay wil - 2), you may have to configure or change the settings.

now open this pro-

gram. To configure and specify an application for Application 1 (the de-
fault Hot-Key setting is for the CD Player application), you must
Table 2 - 4 follow the instructions on the next page.
Hot-Keys

2 - 20 Hot-Keys



Right click the Hot-Key driver icon & on the taskbar and the
following menu will appear.

Setup ¥
oso »
Exit

Select Setup from the menu and scroll to Application 1 and
press Enter.

Browzer 3
E rnail 3
Application 1 Exit

An Open dialog box will appear on the screen.

Browse to the directory where the desired application.exe (see
the sidebar) program exists.

Double-Click on the program file or choose Open.

The Hot-Key is now set to execute that program.

Using The Computer

4

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut.
To find the application
right-click its shortcut
on the desktop and
click Properties. Click
the shortcut (tab) and
see where the execut-
able file is located by
clicking the Find Tar-
get (button).

Hot-Keys 2 - 21
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Function Keys
2 7 y

On the bottom-left of the keyboard is the Fn key or Function key.

Other Keyboards The Fn key allows you to change operational features instantly. To

If your keyboard is use the following functions, press and hold the Fn key; then press the
damaged or you just appropriate function key (F3, F4, F5 etc.) located at the top of your

want to make a keyboard (see “Function Keys and Numeric Keypad” on page 2 -
change, you can use 24)
any standard PS/2 or ’
USB keyboard. The

system will detect and Keys Description
enable it automatically.
However special func- Fn+F3 Turn audio on/off
tions/hot keys unique
to the system’s regular Fn+F4 Toggle between suspend/resume state
keyboard may not
work. Fn+F5 Decrease audio volume
Fn + F6 Increase audio volume
Fn + F7 Toggle between CRT/LCD/LCD and CRT
Fn+F8 Decrease LCD brightness
Tab.le 2-5 Fn+ F9 Increase LCD brightness
Function Keys
Fn + NumLk Enable Number Lock
Fn + ScrLk Enable Scroll Lock

.|
2 - 22 Function Keys



The Numeric Keypad

The keyboard has an embedded numerical keypad for easy numeric
data input. The keypad has a yellow type face (see “Function Keys
and Numeric Keypad” on page 2 - 24).

To use the keypad simply:

Activate the Number Lock feature by pressing the Fn key and the
NumlLk key to the top right of the keyboard. You may check if
Number Lock is enabled or not by looking at the LED status indica-
tors (see “LED Status Indicators” on page 2 - 11).

The Numeric Keypad 2 - 23

Using The Computer
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Special Characters

Some software appli-
cations allow the
number-keys to be
used with Alt to pro-
duce special charac-
ters. These special
characters can only be
produced by using the
numeric keypad. Reg-
ular number keys (in
the upper row of the
keyboard) will not
work. Make sure Num
Lock is on.



Using The Computer

Function Keys and Numeric Keypad

Figure 2 - 11 0 3 53 N
Function Keys & < b iz Wiz Jle M5 Wl Mz s [fls [Hlo [} [}l= [J|*
Numeric Keypad w112 (W m R U:_l v lj o ¢ it -

o DAL‘EID[F G [[H JWKZLELM,‘W ,,.,,
p=t ’ -+

[km z X C v B N Mo

gaca acamge
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TouchPad and Buttons a

The pointing device features a sensitive glide pad for precise move-
ments. It functions the same way as a two-button mouse (the central
Rocker Switch may be configured to function as a “third” button if
you prefer). The right TouchPad button is the same as the right
mouse button; the left TouchPad button is the same as the left mouse
button.

. |
TouchPad and Buttons 2 - 25
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Configuring the TouchPad and Buttons

Once you have installed the TouchPad drivers (see “What to Install”
on page 4 - 2) you can configure the functions from the TouchPad
driver icon BY on the taskbar. You may then configure the Touch-
Pad tracking, buttons and Rocker Switch etc. to your preferences.
You will find further information on this at www.synaptics.com.

e Properis 2 1x]
Flgu]"e 2 - ]2 ) Soroling %) TapZanes @ More Features %) Bulton Actions
. Buttons Pointers Pointer Options Hardware IE) Touch :O Edge Mation
Mouse Properties = - i

Button configuration

Select this check box to make the button on the
right the one pou uge far primary functions such
az selecting and dragging

Double-click speed

Double-click the folder to test your setting. If the
folder does not open or cloze, ty using a slower
setting

Speed:  Slow - Fast |_—|
v

ClickLock
[] Turn on ClickLock

Enables you to highlight or diag without holding down the mouse
button. To set, briefly press the mouse button. To release. click the
mouse button again.

2 - 26 TouchPad and Buttons
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Mouse
/ 2

You can also add a mouse to your computer. You can use a mouse
either through the PS/2 interface or the USB ports (at the rear of the Mouse Driver

computer). If you are using an ex-
ternal mouse your op-
erating system may be

able to auto-configure
your mouse during its
installation or only ena-
ble its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

. |
Mouse 2 - 27
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b Adding a Printer

The most commonly used peripheral is a printer. The following con-
ventions will help you to add a printer, however it is always best to
refer to the printer manual for specific instructions and configuration
options.

USB Printer

Most new printers have a USB interface connection. There are four
USB ports on your notebook computer and you may use any one of
the ports to connect the printer.

Install Instructions:

1. Set up the printer according to its instructions (unpacking,
paper tray, toner/ink cartridge etc.).

2. Turn ON the computer.

3. Turn ON the printer.

4. Connect the printer’s USB cable to one of the USB ports on the
computer.

5. Windows will identify the printer and either load one of its own
drivers or ask you to supply one. Follow the on-screen instruc-
tions.

2 - 28 Adding a Printer



Parallel Printer

This is still the most common type of printer. A Parallel to USB con-
verter may be purchased at most computer stores.

Install Instructions:

1.

wn

oo s

Set up the printer according to its instructions (unpacking,
paper tray, toner/ink cartridge etc.).

Attach the parallel cable to the printer.

Connect the printer’s parallel cable to the parallel port at the
rear of the computer (see “Rear View” on page 1 - 22).

Turn ON the printer.

Turn ON the computer.

Windows (some operating systems may require a driver to rec-
ognize the parallel to USB adapter) will identify the printer and
either load one of its own drivers or ask you to supply one. Fol-
low the on-screen instructions.

Using The Computer
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Parallel to USB
Converter Note

If you are using a Par-
allel to USB converter,
follow the USB installa-
tion instructions on
page 2 - 28.

Adding a Printer 2 - 29
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Advanced Controls

Chapter 3: Advanced Controls
Overview yZ

This chapter covers:
Drivers

e Advanced video controls v .
* Power and battery management features ou are unable to use
most advanced con-

* Audio DJ trols until the neces-

* Infrared Communication (FIR) sary drivers and
utilities are properly in-
stalled (your service
representative may
have already done that
for you). If your system
hasn’t been properly
configured, refer to
“What to Install” on
page 4 - 2, for installa-
tion instructions.

. |
Overview 3 - 1
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Advanced Video Controls

/Zl\ This section is about making adjustments for the LCD, switching dis-
Protecting the LCD play devices.

Do not allow any for- .
eign objects (i.e. paper Openlng the LCD

or plastic) to get be-

*

tween the liLCD and As you open the lid, adjust it so you can look at the screen straight
the work panel. They on, without any glare. If necessary, adjust the brightness controls (Fn
scratch the LCD and/or
accidentally  activate
' &
1 7
,_.._; "“ 15 ﬂn T ]Y Uu‘[l5 OB]P f[]
Figure3-] UC_M [A S D F G [[|H 3Ok 2l @ B,_.n_,
Brightness = =
= “

CHICERCEREC RS + F8/F9) as in Figure 3 - 1.
the close cover switch. RS EES VES VNI
(] # $ % A * ( ° )
2 3 4 5 6 8 9 0 “
Controls NI *
@ =] 1 MMUH@
oo z

3 - 2 Advanced Video Controls



Video Driver Controls

The video interface lets you change the screen resolution and color
output to whatever is most comfortable/efficient for you. This is a
matter of hardware, video memory and the driver for your operating
system. The driver interface shows the available options.

You can switch display devices from the Display Properties control
panel in Windows as long as the video driver is installed (see “What
to Install” on page 4 - 2).

Depending on the configuration purchased, the LCD is capable of
supporting the following resolutions, as long as the video driver is in-
stalled:

« 14.1" XGA TFT LCD - resolution = 1024 * 768
e 14.1" SXGA+ TFT LCD - resolution = 1400 * 1050
 15.0" XGA TEFT LCD - resolution = 1024 * 768
e 15.0" SXGA+ TFT LCD - resolution = 1400 * 1050
 15.0"UXGA TFT LCD - resolution = 1600 * 1200
* 15.0"QXGA TFT LCD - resolution = 2048 * 1536

. |
Video Driver Controls 3 - 3
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Screen Resolution/
Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.
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Figure 3 -2
ATI Display
Settings

Making Adjustments for the Display

The higher the resolution you set the LCD for, the more information
the LCD can display on screen. To change the LCD’s resolution and
color depth go to the Display Properties control panel:

Click Start, point to Settings and click Control Panel.
Double-click Display (icon).

In the Display Properties dialog box, click Settings (tab).

In Screen arealresolution, move the slider to the preferred
setting for resolution (see @ in Figure 3 - 3 on page 3-5).

5. In Colors/Color quality, click the arrow and scroll to the pre-
ferred setting for color depth (see @ in Figure 3 - 3 on page
3-5).

PON=

You can also access Display Properties by right-clicking the ATI
icon in the taskbar. Point to Settings and click Display Settings, then
click the Settings (tab).

4TI Icon Settings

Display Settings

Device Settings

3 - 4 Video Driver Controls



isplay Properties

Themes | Desktop | $creen Saver | Appearance | Seftings

[Cirag the monitor icons to match the physical arangement of your monitors.

Digplay:

‘ 1. Default Moritor on MOBILITY RADEON 7500 L4 |

Scieen resolution Calor quality
— Mare Medium (16 bit) 2
1400 by 1050 pivele I -

Uze this device as the primary manitar,
Extend my Windows desktop onta this monitar,

[ |dentify ][ Tioubleshoot. .. ] [ Advanced €

When the Display Properties control panel is open, click the Ad-
vanced (button) @ to bring up the options tabs. Clicking through

E' Default Monitor and MOBILITY RADEON 7500 Properties

| Troubleshoot ” Color Management " Displays " Calar
OpenGL Direct 3D || Options ” Overlay
General | Adapter | Monitor
Display

If your screen resolution makes screen items too small to view
comfortably, you can increase the DPI to compensate. To change
font sizes only, click Cancel and go to the Appearance tab.

DPI setting:

Mormal size [96 dpi]

Compatibility

Some programs might nat operate properly unless you restart the
computer after changing displap settings.

After | change display settings:

() Restart the computer before applying the new display settings
(&) Apply the new display settings without restarting

() Ask me before applying the new display settings

Some games and other programs must be run in 256-color mode.
Learn more about ranning programms in 256-color mode.

these tabs allows you to make any video adjustments you require.

Advanced Controls

Figure 3 - 3
Advanced
Display
Properties

Video Driver Controls 3 - 5
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Access the menus from ATI taskbar to get further help on display op-
tions, TV options etc. Right-click the ATI icon in the taskbar and
point to Help or Troubleshooting (Figure 3 - 4).

Figure 3 -4
ATl Help &
Troubleshooting

3 - 6 Video Driver Controls

ATI Desktop @
ATI Flak Panel @
ATI Television Display @

4 Schemes

Setkings

Schemes

4 Setkings @

ATI Desktop Help

ATI Television Display Troubleshooting

&Y &

& L1m s:05PM
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Display Devices

Besides the built-in LCD, you can also use an external CRT connect- /
ed to the VGA port as your display device. You may also connect a Drivers
TV. The following are the display options:

You are unable to use
most advanced con-
1. The built-in LCD. trols until the neces-

2. A CRT (external monitor) connected to the VGA port. sary  drivers  and

3. ATV connected to the S-Video connector. utilities are properly in-
stalled. If your system

hasn’t been properly
configured (your serv-
ice representative may
have already done that
for you), refer to “What
to Install” on page 4 -
2, for installation in-
structions.

Display Devices 3 - 7
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Attaching a Monitor (CRT)

/ - Ifyou prefer to use a monitor (CRT), connect it to the External Mon-
Vertical Refresh Rate itor (CRT) port on the rear panel (see “Rear View” on page 1 - 22).

The vertical refresh rate

.. Default Monitor and MOBILITY RADEON 7500 Properties |2 |[X| ; : > |52
Of yOUr CRT is |mp0r- (2= (- (Multiple Monitors) and MOBILITY RADEON 9000 Pro... E|®

Uil 6 35 s v 21uel B oo | v | v | || | e St [ o, Lo |
or yOu're USIng ﬂuOFeS- General Adapter | Monitor | T | Adapler' | Monitar
cent lighting, the screen Menitor type Morier type
will appear to flicker. To @ P @ PR H
reduce flickering on a
CRT, use faster refresh Moniar sstings Monitorsetings
rates (We reCOmmend a Screen efiesh rate: Sereen refresh rate:
refresh rate of 72Hz or 80 Hettz v 60 Hertz 5
more). But first check
your monitor's docu-
mentation to make sure
it can support the rates
listed by the video driv-
er. The default refresh
rate for VGA monitors
(without  drivers) is
60Hz.

Figure 3 -5

Monitor
Properties You can use the Fn + F7 keys to toggle through the display options.

3 - 8 Display Devices
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Display Options ~
TV Support
. Windows 98SE, . You cannot set your
Display Mode Windows ME & XP Windows 2000 flat panel display and
TV to the same display
Single v v mode.
Multiple - Clone Mode v v
Multiple - Extended v Not Available
Desktop Mode Table 3 - 1
Single - Either the LCD, CRT or TV as a display device. Display Options
Multiple (Clone) - The LCD, CRT or TV outputting the same view (you
can apply different display modes with different resolutions and refresh
rates).
Multiple (Extended Desktop) -The LCD, CRT or TV outputting a differ-
ent view (In Windows 98SE, Windows ME and Windows XP only) - see
- “Extended Desktop Mode” on page 3 - 12.

Firstly the display devices must be enabled, then configured to your
requirements.

Display Options 3 - 9



Advanced Controls

4

Primary & Clone
Displays

The Primary display in
an Extended Desktop
environment will be as-
sociated with display
Icon 1 in the settings
tab.

The Clone display will
set the associated dis-
play to show a copy of
the Primary desktop.

The Clone display in
an Extended Desktop
environment will show
the portion of the desk-
top extended from the
Primary display.

Figure 3 -6
Displays Tab

Enabling Other Displays

Attach a monitor to the External Monitor (CRT) port on the rear pan-
el. In the Advanced ATI Mobility Radeon Properties (Figure 3 - 3
on page 3-5) click on Display to get the other display options, in-
cluding those for TV (different OS’s will appear with different op-
tions). Click the enable/disable button E¥] for the display device
you wish to use. Select ONE display as Primary , the remaining
as the Clone (the Clone may operate in either Clone Mode, or
Extended Desktop Mode).

Default Monitor and MOBILITY, RADEON 7500 Properties [2[X] (Multiple Monitors) and MOBILITY RADEON 9000 Pro... [?fX]

OpenGL Direct 30 Options Overlay OperiL Direct3D Oplions Overlay
General Adapter Monior Beneral Adapter M
Displys | P& Color Troubleshoo! | Color Management | Displeys | FZ0 Color

Troubleshoot Color Management

I = |
Hatkey:  [None

|

[ e [ v |7 |

1=

Not Connected Not Connected 140041050 1400:1050 Not Ennnfcted

S ) e Sakp ) e 0z b )
o8 | o8

o[ coma ] (e ] ok [ cawel | i Help
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Clone Mode

Clone Mode simply shows an exact copy of the Primary display
desktop on the other display(s). This mode will drive multiple dis-
plays with the same content. Use this feature to display the screen
through a projector for a presentation. Each display device can be
configured independently as this allows you to set the options for
overhead projectors etc., which require specific resolutions and re-
fresh rates.

.|
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Extended Desktop Mode

The system supports Extended Desktop (the LCD and a CRT show-

ing different views) in multiple display environments in Windows
98SE, Windows ME and Windows XP, but this mode is NOT sup-
ported in Windows 2000. An Extended Desktop creates a desktop
spanning multiple displays and acts as a large workspace.

To get this effect:

1. Attach your external monitor to the External Monitor (CRT) port
(or TV to the S-Video connector), and turn it on.

2. Go to the Advanced Display Settings (see Figure 3 - 3 on
page 3-95).

3. Select the Displays tab (see Figure 3 - 6 on page 3-10).

4. Click the enable/disable button E¥ for the display device you
wish to use.

5. Click Apply and an image will appear on the display device
(give the monitor a few seconds for the image to refresh).

6. Click Yes to accept the settings and OK to save the changes.

7. Use the Display Properties window to select the second mon-
itor by clicking on the icon, or by selecting it from the “Display:”
pop-up menu.

8. Click “Extend my Windows desktop onto this monitor.”
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9. Click Apply (click Yes to keep the settings if prompted).

10. Use the Display Properties control panel to drag the monitors
to match the physical arrangement you wish to use.

11. In the example shown in Figure 3 - 7 the primary monitor @ is a
on the left, the other display is on the right.

S \Su s | Click either the Display

Themes | Desktap | Ser

bt st || bop-un menu, or click Figure 3 -7
the icon for the Extended
E 2 | appropriate  display. Desktop Monitor
Then click the tick box Arrangement
to extend the primary

0BILITY RADEON 7500 H ] .
display’s desktop to it.

”

Extend my ‘Wwindows desktop onto this moritar.
—

[ ldentity || Troubleshaot.. | [ Advanced | /

C o oot J [ e ] Help

Further help is availa-

12. With the Extended Desktop Mode enabled, drag any icons or ble through the menus
windows across to the other display desktop. It is therefore accessed from the
possible to have one program visible in one of the monitors, taskbar (see Figure 3 -
and a different program visible in the other monitor. 4 on page 3-6).

.|
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13. One display will be set to 1 (Primary), and the other to 2

(Clone). The displays may be switched as long as one as set to
Primary.

. (Multiple Monitors) and MOBILITY RADEON 9000 Pro... [2][X]
Figure 3 -8

OpenGL Directad Options Overlay
H General | Adapter Monitor
Displays Tab

Desktop Mode)

11524864 1400+1050 gzl
60 He 60H:

—5 )

e | @8

[0k J [ Caneed J [ eob J [ Hee ]

14. To switch from Extended Desktop mode back to Clone mode,
first uncheck the tick box to disable the Extended Desktop (via
the settings tab in the Display Properties control panel) and
click Apply (see “Extended Desktop Monitor Arrangement”
on page 3 - 13).

15. Repeat the procedure in “Enabling Other Displays” on
page 3 - 10 to return to Clone mode (click the &7 button to
enable displays if necessary).
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Enabling TV Display

To display desktop images on a TV display, connect the TV to your
computer by using an S-Video cable from the TV to the connector at
the rear of the computer (see “Rear View” on page 1 - 22). You will
need to enable the TV display from the Displays tab (Figure 3 - 6 on

page 3-10).

Further help is available to help you troubleshoot your TV connec-
tion through the menus accessed from the taskbar (see Figure 3 - 4

on page 3-6).

OpenBL Direct 3D Oplions
General Adapler
Troubleshoot | Color Management Displays
Scheme
T

B e [ e |7
‘ 1
P

Sy

Not Connected
o—

Not Connected

140041050
60Hz

o2& ©J[=] o8

2UXI B peskrop Help

Dplions

TV Format

To select your TV broadcast format by country (if available)
1 Click here 3] to view Dizgplay Properties at the Settings tab.

2 Click the Advanced button

3 Click the Displays tab

B, you rmust first select the video adapter
change. Click here for more informatian

whose display properties
4 Click the TV button

Your TV must be enabled before you can change its display properties. Click here
for mare information.

5 Click the Format tab (if available)

6 In the Country box, select a country from the list (if available).
7 Click Ok or Apply to save the changes you have made.

Note

« In general, there is only one broadcast format supported by a given country

[ ok [ cancel ] [ hHep ]

_I Related Topics

Advanced Controls

4

TV Format

If you need to change
the format for TV
Broadcast, plug your
TV in to the S-Video
connector then go to
Display Properties >
Settings > Advanced
> Displays and click
TV (button).

Click the Format (tab)
and select a country
from the list.

Figure 3 -9
TV Format
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4

OS Note

Power management
functions  will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user's manual of your
operating system.

(Note: All pictures
used on the following
pages are from the
Windows XP OS).

Power Management Features

To conserve power, especially when using the battery, your note-
book computer has ACPI power management available. Power man-
agement conserves power by controlling individual components of
the computer (the monitor and hard disk drive) or the whole system.

Advanced Configuration and Power Interface
(ACPI)

The ACPI interface provides the computer with enhanced power
saving techniques and gives the operating system (OS) direct control
over the power and thermal states of devices and processors. For ex-
ample, it enables the OS to set devices into low-power states based
on user settings and information from applications. ACPI is fully
supported in Windows ME, Windows 2000 and Windows XP.

.|
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Intel SpeedStep Technology Applet

This applet helps your system take advantage of a SpeedStep-en-
hanced CPU’s capabilities, such as that as found in your notebook if
you have the mobile CPU option.

Once activated, the system can dynamically monitor and adjust the
CPU’s speed, without the need to shutdown, reboot, or go into Sus-
pend mode.

Instructions on installing SpeedStep (if you have a mobile CPU) are
in “What to Install” on page 4 - 2.

The SpeedStep Control Panel is available by going to Start
(menu), point to Settings and click Control Panel. Double-Click
Power Management/Power Options.

.|
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Mobile CPU

Intel SpeedStep will
only take advantage of
the enhanced capabili-
ties of the mobile CPU.
If your computer is
based on the desktop
CPU then there is no
need to install the
SpeedStep Applet.

If you are unsure of
your CPU type check
the POST screen infor-
mation (see “POST
Screen” on page 5 -
4). If you have a mobile
CPU it will have the
suffix “- M” after the in-
formation on the CPU
e.g. “Pentium (R) 4 -
M”.
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Enabling Power Management/Options

The power management/options are enabled through the Control

Panel in your Windows system (Power Management in Windows
98SE, and Power Options in the Windows ME, 2000 and XP). With
other operating systems you may have power management available
so check your documentation.

-
Figure 3 - 10
. Power Schemes | Alaims | Power Meter | Advanced | Hibemate
Power Options

o
J;b Select the power-zaving settings pou want to use,

Options
[ ways show icon on the taskbar

Frompt for password when computer resumes from standby

Fower buttons
“when | close the lid of my portable computer:

Stand by A

‘When | press the power button on my computer:

Shut down v

‘when | press the sleep button on my computer:

Stand by £

You may conserve power through individual components or
throughout the whole system.
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Conserving Power Through Individual

Components
Monitor Standby

To conserve power, you can set the monitor to turn off after a speci-

fied time.

Hard Disk Standby

The computer's hard disk motor will be turned off if the hard disk
drive has not been accessed for a specified period of time. If the sys-
tem reads or writes data, the hard disk motor will be turned back on.

Power Options Properties

Power Schemes | Advanced | Hibemate | UPS

Settings for Home/Office Desk power scheme

Tum off moritor: After 20 ming

Tum off hard digks: Mever

System standby: Mever

Enabling Power Management/Options 3 - 19

Advanced Controls

4

Resuming Operation

The  system can
resume from Monitor
or Hard Disk Standby
by pressing a key on
the keyboard.

Figure 3 - 11
Power Schemes
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2 &
Hibernate Mode In
Windows 98SE

Hibernate mode is not
available in Windows
98SE.

Conserving Power Throughout the Whole System
With this function you can stop the notebook’s operation and restart
where you left off. This system features Standby and Hibernate
suspend mode levels (Hibernate mode will need to be enabled by
clicking the option in the Hibernate tab in the Power Options con-
trol panel).

Hibernate Mode vs. Shutdown

“Hibernate Mode” and “Shutdown” are the same in that the system
is off and you need to press the power button to turn it on. Their main
difference is:

When you come back from hibernation, you can return to where you
last left off (what was on your desktop) without reopening the appli-
cation(s) and file(s) you last used.

You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put
the system on standby instead of in hibernation. It takes a longer time
to wake up the system from Hibernate Mode than from Standby
Mode.
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Standby

Standby saves the least amount of power, but takes the shortest time

to return to full operation. During Standby the hard disk is turned off, g
and the CPU is made to idle at its slowest speed. All open applica-

tions are retained in memory. When you are not using your computer

for a certain length of time, which you specify in the operating sys-

tem, it will enter Standby mode to save power.

The system can resume from Standby mode by:

» Pressing the key combination Fn + F4 (see “Function Keys” on
page 2 - 22).

* Pressing the Power Button.

* An alarm resume that is enabled and expires.

* Pressing a key on the keyboard.

* An incoming call is received on the modem.
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Hibernate
7&; Hibernate uses no power and saves all of your information on a part
. of the HDD before it turns the system off. Although it saves the most
Hibernate Mode In . . .
Windows 98SE power it takes the longest time to return to full operation. You can set

your notebook to automatically enter Hibernate mode when the bat-
tery power is almost depleted.

Hibernate mode is not
available in Windows
98SE.

The system will resume from Hibernate mode by:

* Pressing the key combination Fn + F4 (see “Function Keys” on
page 2 - 22)
* Pressing the power button.
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Configuring the Power Button

The Power button may be set to send the computer in to either Stand-
by or Hibernate modes (Figure 3 - 12). In Standby mode the LED
Dy will flash green, in Hibernate mode the LED will be off. If
you are in a power saving mode set to save power through individual
components (e.g. hard disk, monitor), the LED will remain green.

Power Options Properties E| Figure 3-12
Power Schemes || Alarms | Power Meter | Advanced | Hibernate Advanced Power
Options

e 9 ] .

"_Lb Select the power-saving setlings you want to use.
Optiong
[ Ahways show icon on the taskbar

Frompt for pazsword when computer resumes from standby

Power buttons
‘when | cloze the lid of my portable computer:

Stand by v

‘when | press the power buttan on my computer:

Shut down v
Do nathing

Agk me what to do

Stand b
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ZRS
Battery Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.

Battery Information

Please follow these simple guidelines to get the best use out of your
battery.

New Battery
Always charge a new battery before using it.

Battery Life

Your notebook computer’s battery life is dependent upon many fac-
tors, including the programs you are running, and peripheral devices
attached. Power Management settings in the OS will help prolong the
battery life if configured appropriately.

Battery life may be shortened through improper maintenance. To op-
timize the life and improve its performance, fully discharge and re-
charge the battery at least once every 30 days.

.|
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Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low
battery. Don’t turn off the computer by yourself even when you see

a message that indicates the battery is critically low, just let the com-

puter use up all of the battery power and shut down on its own (it is

best to disable the Power Options/Management functions in the

Control Panel). As the battery nears the end of its life close any crit-

ical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indi-
cator light stops flashing.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30
days or after about 20 partial discharges.
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Conserving Battery Power

Display Brightness
The LCD display consumes a lot of power, so lowering the bright-
ness level will save power.

Applications and External Devices

Different applications and external devices consume battery power
even when they are not being used.

To conserve battery power we recommend:

* Closing modem or communication applications when they are not
being used.

* Removing any unused PC Cards from the computer (PC Cards quickly
use up battery power even if the system enters Suspend mode).

» Disconnecting any unnecessary external devices from the computer.
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Removing and Replacing the Battery

Usually you will not need to remove your battery. If you follow the
tips given to manage and extend your battery life on the preceding
pages your battery should last a long time. However there may be
times when you are required to remove, swap or replace the battery.
In these cases please follow these instructions:

1. Shut the computer down and turn it over.

2. Locate the battery release latch @) in Figure 3 - 13.
3. Slide the battery release latch towards the unlock symbol.

Figure 3 - 13
Battery Release
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4. The battery will pop-up and can be lifted out of the computer.
5. Slide the new battery in and carefully push it down until the
latch snaps back in to position.
Figure 3 - 14
Battery Out
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Audio “DJ” CD Player

The built-in standalone audio CD player gives you direct hardware lﬂ\

control for audio CDs when the computer is shut down, but has a Turning the
Computer On

working power source.
Note: If you are play-

1. Make sure that the computer is shut down (i.e. the operating ing a CD in the audio
system is not running) but you have a working power source playeryouwillnotbe

. . able to use the power
(either running from the battery or AC Power). button to switch the

2. Toggle the ON/OFF (@ in Figure 3 - 15) switch by moving it to computer on. Switch
the right and then releasing it. the CD audio player off
3. The switch will automatically move back to the left and the LCD first, then press the
will become active. power button to turn on
4. Press the Open Button on your CD device and carefully place LTS

an audio CD disc onto the disc tray with label-side facing up. When the computer is

(DVD drives will also play audio CD’s). turned on the control

5. Gently push the CD/DVD tray in until its lock “clicks” and you for all CDs passes to

are ready to start. the operating system’.s

6. The Busy Indicator will light up while data is being accessed (or [l raaiHER LR

. . . not be able to turn on

while a CD is playing). the audio “DJ” until the

7. The LCD will display a @ for the first CD track. computer is turned off
8. Click the play/pause button to start the CD. again.
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9. You can control the CD tracking and audio volume from the

/ \ control panel.
10. The player can be turned off by toggling the ON/OFF switch
Sound Volume again.

Adjustment

How high the sound
volume can be set us-
ing the volume control
knob depends on the
setting of the volume
control  within  Win-

}[5 0 Q0O
@@ O aSED
dows. Click the Speak-
er icon on the taskbar

to check the setting. 1. CD Player Control Panel On/Off Switch
The volume controls 2. Previous Track
on the Audio DJ player 3. Next Track
still control the volume 4. LCD
settings if the compu- 5. Play Pause
ter's operating system 6. Stop
is running. 7. Volume Down
8. Volume Up
Figure 3 - 15
Audio “DJ”
Controls
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Configuring the Infrared Settings for
FIR Z

L Infrared
To configure your computer for Fast Infrared (FIR) communication e e

follow these steps:

The Infrared transceiv-
er operates on a “Line

1. Click Start, point to Settings and click Control Panel. of Sight”.
2. Double-click Wireless Link icon (Windows XP/2000)/Network
(Windows 98SE/ME). gfllaks_ surteh ngtLhing isf
H H . OCKINn e Ine o
3. Depending on your OS, do the following: Sight’ gbetween Sour
system’s transceiver
* In Windows XP/2000 click Hardware (tab), and click Proper- and the destination’s
ties (button), then click the Advanced (tab). transceiver.

* In Windows 98SE/ME click IrDA v3.0 Fast Infrared Port and
click Properties (button) then click the Advanced (tab).

4. Select “Infrared Transceiver A” and change the Value to “HP
HSDL-2300/3600".

5. Click OK > OK.

6. Restart the computer if prompted to do so.

For further information, please refer to the manual of the device you

wish to connect.
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Enabling Infrared Communication in Windows 98SE

In Windows 98SE you will need to enable Infrared communication

from the control panel:

Click Start, point to Settings and click Control Panel.
Double-click Infrared icon.

Click the Options (tab).

Click Enable Infrared communication.

Click OK.

aorwN =



Drivers & Utilities

Chapter 4: Drivers & Utilities

Ove rVieW o Windows 98 Second Edition
*  Windows ME

*  Windows 2000 Professional
This chapter deals with installing the drivers « Windows XP
and utilities essential to the operation or im-
provement of some of the notebook PC’s sub-
systems. The system takes advantage of some
newer hardware components for which the lat-
est versions of most available operating sys-
tems haven’t built in drivers and utilities.
Thus, some of the system components won’t /
be auto-configured with an appropriate driver

o . . . . Assumption
or utility during operating system installation.
Instead, you need to manually install some We assume that you will install all drivers and
. . e . utilities from the built-in CD device and it is as-
system-required drlve.rs and utﬂ_lt.les'. In this signed to Drive D: In addition, all file exten-
chapter, we group driver and utility installa- sions can be seen [see “Navigate (Browse..)
tion instructions by operating system. The fol- to D:” on page 4 - 3].

lowing operating systems are covered.

. |
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What to |nsta|| For Windows 98SE the install order is as

follows:
The Device Drivers & Utilities + User’s Man-

ual CD-ROM contains the drivers and utilities 4 Chipset
necessary for the proper operation of the note- 2. | AN
D book PC. Table on page 4-4 lists what you 3. Audio
need to install manually according to your 4. Modem
choice of the operating system. 5. Video

You should install the drivers in the following
order for all OS’s except Win98SE:

Chipset
Audio
Modem
LAN
Video

OrON~

All other drivers may follow in any order you
wish, however it is very important that these
drivers are installed in the order indicated
above.
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Navigate (Browse..) to D:

You will notice that many of the instructions for
driver installation require you to Navigate
(Browse) to D:

In this case D: is the drive specified for your CD
device. Not all computers are setup the same
way, and some computers have the CD listed
under a different drive letter - e.g. if you have
two hard drives (or hard disk partitions) one
may be designated as drive C: and the other as
D: In this case the CD device may be designat-
ed as drive E: - Please make sure you are ac-
tually navigating to the correct drive letter for
the CD device.

When you click the Browse (button) after click-
ing Run in the Start menu you will see the
“Look in:” dialog box at the top of the Browse
window. Click the scroll button to navigate to
My Computer to display the devices and drive
letters.

Drivers & Utilities

Authorized Driver Message

If you receive a message telling you that the
driver you are installing is not authorized
(Digital Signature Not Found), just click
Yes or Continue Anyway to ignore the mes-
sage and continue the installation procedure.

You will receive this message in cases where
the driver has been released after the version
of Windows you are currently using. All the
drivers provided will have already received
certification for Windows.

Version Conflict Message

During driver installation if you encounter any
“file version conflict” message, please click
Yes to choose to keep the existing (newer)
version.

What to Install 4 - 3
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Table 4 - 1 - Install Procedure

Feature Win98SE Feature WinME Win 2000 Win XP
Chipset Page 4-5 Chipset Page 4 - 11 Page 4 - 17 Page 4 - 22
D LAN Page 4 - 6 Audio Page 4 - 11 Page 4 - 17 Page 4 - 22
Audio Page 4-7 Modem Page 4 - 12 Page 4 - 18 Page 4 - 23
Modem Page 4-7 LAN Page 4 - 13 Page 4 - 19 Page 4 - 24
Video Page 4 - 8 Video Page 4 - 13 Page 4 - 19 Page 4 - 25
TouchPad Page 4 -8 TouchPad Page 4 - 14 Page 4 - 19 Page 4 - 25
Hot-Key Page 4 -9 Hot-Key Page 4 - 14 Page 4 - 20 Page 4 - 25
Auto Mail Page 4-9 Auto Mail Page 4 - 15 Page 4 - 20 Page 4 - 26
Intel SpeedStep * | Page 4-10 | Intel SpeedStep * | Page 4-15 Page 4 - 21 N/A
Wireless LAN Page 4-10 | Wireless LAN Page 4 - 16 Page 4 - 21 Page 4 - 26
USB 2.0 Page 4-10 | USB 2.0 Page 4 - 16 Page 4 - 21 Page 4 - 26

*Intel SpeedStep Note: This applet helps your system take advantage of a SpeedStep-enhanced CPU’s
capabilities, such as that as found in your notebook if you have the mobile CPU option. If you do not
have the mobile CPU option there is no need to install the driver (see “Mobile CPU” on page 3 - 17).
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Windows 98 Second Edition

This section covers driver and utility installa- Chipset (Win98SE)
tion instructions for Windows 98 Second Edi- | (lick Start (menu) > Run...

tion. 2. Navigate (Browse..) to D:\Driv-
ers\CHIPSET\Setup.exe and click OK. a

What To Have Ready

3. To continue press Next > Yes > Next.
4. Click Finish to restart the computer.
5. Windows will then tell you “New Hard-

In some cases when drivers are to be installed ware Found” and begm to install the

you will need to have present your OS CD - dri.Vel“S for you.

Windows 98 Second Edition. 6. Click Next and select “Search for the
If prompted you may swap your Device Drivers best driver for your device. (Recom-
& Utilities + User’s Manual CD-ROM with your men ded) )

OS CD-ROM and back again when required. 7 Click Next again.

8. Make sure you have not selected any
locations to search, then click Next >
Next > Finish.

9. Click Yes to restart the computer when
prompted.

Windows 98 Second Edition 4 - 5
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LAN (Win98SE)

1.

~o

Click Start (menu), point to Settings and
click Control Panel. Double-click Sys-
tem (icon) and then click Device Man-
ager (tab).

Click “+” next to Other devices (if its
sub-items are not shown).

Double-click PCI Ethernet Controller
and click Reinstall Driver (button).
When the Update Device Driver Wizard
appears, click Next > Next (make sure
that you have selected “Search for a bet-
ter driver than the one your device is
using now. (Recommended)”).

Select ONLY “Specify a location”
(make sure the other boxes do not have a
tick inside them) and navigate
(Browse...) to D:\Drivers\LAN\win98se.
Click OK > Next > Next.

When you are prompted ‘Please insert
the disk labeled “Windows 98 Second
Edition CD-ROM?” and then click OK’

10.

eject the CD-ROM in your drive and
insert the Windows CD.

Give the computer a few seconds to rec-
ognize that the disk is in the drive, then
click OK.

Click Finish > Yes to restart the compu-
ter when prompted.

The network adapter is now ready for
configuration.

. |
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Audio (Win98SE)

1.
2.

3.
4.
5

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\AUDIO\Setup.exe and click OK.
To continue click Next.

Click Finish to restart the computer.
Windows will then tell you “New Hard-
ware Found” and begin to install the
drivers for you.

When you are prompted ‘Please insert
the disk labeled “Windows 98 Second
Edition CD-ROM” and then click OK’
eject the CD-ROM in your drive and
insert the Windows CD.

Give the computer a few seconds to rec-
ognize that the disk is in the drive, then
click OK (click Yes if asked if you want
to continue at any time).

You will see the Volume Control appear
in the taskbar alongside the date after
you restart the computer.

Drivers & Utilities

Modem (Win98SE)

1.

Click Start (menu), point to Settings and
click Control Panel. Double-click Sys-
tem (icon) and then click Device Man-
ager.

Click “+” next to Other devices (if its
sub-items are not shown).

Double-click PCI Card and click Rein-
stall Driver (button).

When the Update Device Driver Wizard
appears, click Next > Next (make sure
that you have selected “Search for a bet-
ter driver than the one your device is
using now. (Recommended)”).

Select ONLY “Specify a location:”
(make sure the other boxes do not have a
tick inside them) and navigate
(Browse...) to D:\Driv-
ers\Modem\WIN98SE and click OK >
Next > Next.

When you are prompted ‘Please insert
the disk labeled “Windows 98 Second
Edition CD-ROM?” and then click OK’
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eject the CD-ROM in your drive and
insert the Windows CD.

Give the computer a few seconds to rec-
ognize that the disk is in the drive, then
click OK > Finish.

Close the Smart Link 56K Voice
Modem Properties and System Proper-
ties (dialog box). The modem is ready
for dial-up configuration.

4

Modem Country Selection

Be sure to check if the modem country selection
is appropriate for you (Control Panel > Mo-
dems).

Video (Win98SE)

1.
2.

3.

4,

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\VIDEQO\Setup.exe and click OK.

To continue click Next > Yes > Express
(button).

Click Finish to restart the computer when
prompted.

TouchPad (Win98SE)

1.
2.

Nk W

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\touchpad\WIN98SE\Setup.exe and
click OK.

Choose the language you prefer.

To continue click Next > Next > Next.
Click Finish to restart the computer when
prompted.

You may then configure your TouchPad
as outlined in “TouchPad and Buttons”
on page 2 - 25.
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Hot-Key (Win98SE)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Driv-
ers\KBC_AP\CNKO001.exe and click
OK.

3. Choose the language you prefer.

4. Click Next.

5. Click Finish to restart the computer when
prompted.

6. You may then configure your Hot-Key

Buttons as outlined in “Hot-Keys” on
page 2 - 19.

Drivers & Utilities

Auto Mail (Win98SE)

1.
2.

SAINAIE il

Click Start (menu) > Run...

Navigate (Browse..) to D:\Drivers\Auto-
mail\setup.exe and click OK.

To continue click Next > Next.

Click Finish to complete the setup.
Restart the computer.

You may run and configure the program
from the Start (menu).

Point to Programs > Auto Mail
Checker and click Auto Mail Checker.
You may then access the program settings
through the icon in the taskbar. For fur-
ther details see “Auto Mail Checker” on
page 2 - 8.
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Intel SpeedStep (Win98SE) Wireless LAN (Win98SE)

*Intel SpeedStep Note: This applet helps 1. Click Start (menu) > Run...
your system take advantage of a SpeedStep- 2. Navigate (Browse..) to D:\Driv-

enhanced CPU’s capabilities, such as that as ers\WLAN\GW-LANSetup.exe and
found in your notebook if you have the mo- Cli?k OK.
p bile CPU option. 3. Click Next > Next > Yes.
4. Click Finish to restart the computer when
If you do not have the mobile CPU option prompted.
there is no need to install the driver (see “Mo- 5. After restart Windows will install the
bile CPU” on page 3 - 17). drivers for you.

6. Click Yes to restart the computer again.

1. Click Start (menu) > Run... .
2. Navigate (Browse..) to D:\Driv- USB 2.0 (Win98SE)
ers\SpeedStep\(Your lan- The USB 2.0 driver is only required for Model

guage)\Disk1\Setup.exe and click OK. C (see “USB Port Type” on page 1 - 7).
3. Click Next > Yes.

4. Click Finish to restart the computer when | ([ick Start (menu) > Run...
prqmpted. ) . 2. Navigate (Browse...) to D:\Driv-

5. Cl}Ck Start (menu), point to Set.tlngs and ers\USB20\Setup.exe and click OK.
click Control Panel. Double-click the 3 Click Next > Next.
Power Management (icon) and then 4. Click Finish to restart the computer when
choose your settings on Intel SpeedStep prompted.
technology (tab).

. |
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Windows ME

This section covers driver and utility installa-
tion instructions for Windows ME.

Chipset (WinME)

1.
2.

3.
4.
5

Windows ME 4 - 11

Click Start (menu) > Run...

Navigate (Browse.) to D:\Driv-
ers\CHIPSET\Setup.exe and click OK.
To continue press Next > Yes > Next.
Click Finish to restart the computer.
Windows will then tell you “New Hard-
ware Found” and begin to install the
drivers for you.

Select “Automatic search for a better
driver (Recommended)” and click Next
> Finish.

Click Yes to restart the computer when
prompted.

Drivers & Utilities

Audio (WinME)

S

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\AUDIO\Setup.exe and click OK.
Click Next.

Restart Windows when prompted by
clicking Finish.

Go to the Sounds & Multimedia Con-
trol Panel (Start Menu and point to Set-
tings and click Control Panel then
double-click the Sounds & Multimedia
icon).

Click the Audio tab.

Click Advanced in the Sound Playback
Menu.

Under Speaker Setup select 5.1 Sur-
round Speakers from the pull-down
menu and click OK > OK to close.
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Modem (WinME)

1.

*®

Click Start (menu), point to Settings and
click Control Panel. Double-click Sys-
tem (icon) and then click Device Man-
ager.

Click “+” next to Other devices (if its
sub-items are not shown).

Double-click PCI Card and click Rein-
stall Driver (button).

When the Update Device Driver Wizard
appears, select “Specify the location of
the driver (Advanced)” and click Next.
Make sure that you have selected
“Search for a better driver than the
one your device is using now. (Recom-
mended)”.

Select ONLY (make sure the other boxes
do not have a tick inside them) “Specify
a location”, and navigate (Browse...) to
D:\Drivers\Modem\WINME.

Click OK > Next > Next.

Repeat the process outlined in Steps 4
through 7 as follows.

4 - 12 Windows ME

10.

I1.

12.
13.

14.

Select “Specify the location of the
driver (Advanced)” then click Next.
Make sure that you have selected
“Search for the best driver for your
device. (Recommended).”.

Select ONLY (make sure the other boxes
do not have a tick inside them) “Specify
a location:”, and navigate (Browse...) to
D:\Drivers\Modem\WINME.

Click OK > Next > Next.

Click Finish and close the open win-
dows.

The modem is ready for dial-up configu-
ration.

e

Modem Country Selection

Be sure to check if the modem country selection
is appropriate for you (Control Panel >Mo-
dems).



LAN (WinME)

1.

Windows ME 4 - 13

Click Start (menu), point to Settings and
click Control Panel. Double-click Sys-
tem (icon) and then click Device Man-
ager (tab).

Click “+” next to Network Adapters (if
its sub-items are not shown).
Double-click Realtek RTL8139(A)-
based PCI Fast Ethernet Adapter.
Click the Driver (tab) and click the
Update Driver (button).

When the Update Device Driver Wizard
appears, select “Specify the location of
the driver (Advanced)” and click Next.
Make sure that you have selected
“Search for a better driver than the
one your device is using now. (Recom-
mended)”.

Select ONLY (make sure the other boxes
do not have a tick inside them) “Specify
a location:”, and navigate (Browse...) to
D:\Drivers\LAN\winme.

Click OK > Next > Next.

9.

Drivers & Utilities

Click Finish and Yes to restart the com-
puter when prompted.

10. The network adapter is now ready for

configuration.

Video (WinME)

1.
2.

3.
4,

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\VIDEOQO\Setup.exe and click OK.
To continue click Next > Yes > Express.
Click Finish to restart your computer
when prompted.
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TouchPad (WinME)

1.
2.

kW

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\touchpad\WINME\Setup.exe and
click OK.

Choose the language you prefer.

To continue click Next > Next > Next.
Click Finish to restart the computer when
prompted.

You may then configure your TouchPad
as outlined in “TouchPad and Buttons”
on page 2 - 25.
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Hot-Key (WinME)

1.
2.

nbkw

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\KBC_AP\CNKO001.exe and click
OK.

Choose the language you prefer.

Click Next.

Click Finish to restart the computer when
prompted.

You may then configure your Hot-Key
Buttons as outlined in “Hot-Keys” on
page 2 - 19.



Auto Mail (WinME)

1.
2.

SNk w

Click Start (menu) > Run...

Navigate (Browse..) to D:\Drivers\Auto-
mail\setup.exe and click OK.

To continue click Next > Next.

Click Finish to complete the setup.
Restart the computer.

You may run and configure the program
from the Start (menu).

Point to Programs > Auto Mail
Checker and click Auto Mail Checker.
You may then access the program settings
through the icon in the taskbar. For fur-
ther details see “Auto Mail Checker” on
page 2 - 8.

Drivers & Utilities

Intel SpeedStep (WinME)

*Intel SpeedStep Note: This applet helps
your system take advantage of a SpeedStep-
enhanced CPU’s capabilities, such as that as
found in your notebook if you have the mo-
bile CPU option.

If you do not have the mobile CPU option
there is no need to install the driver (see “Mo-
bile CPU” on page 3 - 17).

1. Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\SpeedStep\(Your lan-
guage)\Disk1\Setup.exe and click OK.

3. Click Next > Yes.

4. Click Finish to restart the computer when
prompted.

5. Click Start (menu), point to Settings and
click Control Panel. Double-click the
Power Options (icon) and then choose
your settings on Intel SpeedStep tech-
nology (tab).
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Wireless LAN (WinME)

1.
2.

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\WLAN\GW-LANSetup.exe and
click OK.

Click Next > Next > Yes.

Click Finish to restart the computer when
prompted.

After restart Windows will install the
drivers for you.

Click Yes to restart the computer again.
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USB 2.0 (WinME)

The USB 2.0 driver is only required for Model
C (see “USB Port Type” on page 1 - 7).

1. Click Start (menu) > Run...
Navigate (Browse...) to D:\Driv-
ers\USB20\Setup.exe and click OK.

3. Click Next > Next.

4. Click Finish to restart the computer when
prompted.



Windows 2000 Professional
Audio (Win2000)

This section covers driver and utility installa-
tion instructions for Windows 2000 Profes-
sional.

2N
&

Service Pack 2

Make sure you have installed Windows 2000
Service Pack 2.

Chipset (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse.) to D:\Driv-
ers\CHIPSET\Setup.exe and click OK.

3. To continue press Next > Yes > Next.

4. Click Finish to restart the computer when
prompted.

Drivers & Utilities

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\AUDIO\Setup.exe and click OK.
Click Next.

Restart Windows when prompted by
clicking Finish.

Go to the Sounds & Multimedia Con-
trol Panel (Start Menu and point to Set-
tings and click Control Panel then
double-click the Sounds & Multimedia
icon).

Click the Audio tab.

Click Advanced in the Sound Playback
Menu.

Under Speaker Setup select 5.1 Sur-
round Speakers from the pull-down
menu and click OK > OK to close.

Windows 2000 Professional 4 - 17
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Modem (Win2000)
1. Click Start (menu), point to Settings and

click Control Panel. Double-click Sys- /
tem (icon) and then click Hardware
(tab) > Device Manager (button). Modem Country Selection
p 2. Click “4+” next to Other devices (if its 5 : .
e sure to check if the modem country selection

sub-items ?’re not show.n). . . is appropriate for you (Control Panel > Phone
3. Double-click PCI Device and click Rein- and Modem Options).

stall Driver (button) and click Next.

4. When the Upgrade Device Driver Wizard
appears, select “Search for a suitable
driver for my device (recommended)”
and click Next.

5. Select ONLY (make sure the other boxes
do not have a tick inside them) “Specify
a location”, and click Next.

6. Navigate (Browse...) to D:\Driv-
ers\Modem\Win2000.

7. Click Open > OK > Next.

8. Click Finish and close the open win-
dows.

9. The modem is ready for dial-up configu-
ration.

. |
4 - 18 Windows 2000 Professional



LAN (Win2000)

1.

8.

9.

Click Start (menu), point to Settings and
click Control Panel. Double-click Sys-
tem (icon) and then click Hardware
(tab) > Device Manager (button).

Click “+” next to Network Adapters (if
its sub-items are not shown).
Double-click Realtek RTL8139(A)-
based PCI Fast Ethernet Adapter and
click the Driver tab.

Click the Update Driver (button).
When the Upgrade Device Driver Wizard
appears click Next.

Select “Search for a suitable driver for
my device (recommended)” and click
Next.

Select ONLY (make sure the other boxes
do not have a tick inside them) “Specify
a location”, and click Next.

Navigate (Browse...) to D:\Driv-
ers\LAN\win2000.

Click the Open (button) and click OK
(button), then click Next.

10. Click Finish, and close the window.

Windows 2000 Professional 4 - 19

Drivers & Utilities

Video (Win2000)

1.
2.

3.
4,

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\VIDEQO\Setup.exe and click OK.

To continue click Next > Yes > Express.
Click Finish to restart the computer when
prompted.

TouchPad (Win2000)

1.
2.

oW

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\touchpad\WIN2000\Setup.exe and
click OK.

Choose the language you prefer.

To continue click Next > Next > Next.
Click Finish to restart your computer
when prompted.

You may then configure your TouchPad
as outlined in “TouchPad and Buttons”
on page 2 - 25.
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Hot-Key (Win2000)

1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Driv-

ers\KBC_AP\CNKO001.exe and click

OK.
Choose the language you prefer.
Click Next.

kW

when prompted.

6. You may then configure your Hot-Key
buttons as outlined in “Hot-Keys” on

page 2 - 19.
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Click Finish to restart your computer

Auto Mail (Win2000)

1.
2.

SAINAIE il

Click Start (menu) > Run...

Navigate (Browse..) to D:\Drivers\Auto-
mail\setup.exe. and click OK.

To continue click Next > Next.

Click Finish to complete the setup.
Restart the computer.

You may run and configure the program
from the Start (menu). Point to Pro-
grams > Auto Mail Checker. and click
Auto Mail Checker.

You may then access the program settings
through the icon in the taskbar. For fur-
ther details see “Auto Mail Checker” on
page 2 - 8.
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Intel SpeedStep (Win2000) Wireless LAN (Win2000)

*Intel SpeedStep Note: This applet helps 1. Click Start (menu) > Run...
your system take advantage of a SpeedStep- 2. Navigate (Browse..) to D:\Driv-

enhanced CPU’s capabilities, such as that as ers\WLAN\GW-LANSetup.exe and
found in your notebook if you have the mo- Ch?k OK.
bile CPU option. 3. Click Next > Next > Yes.
4. Select the appropriate Domain Settings
and click Apply.

If you do not have the mobile CPU option
there is no need to install the driver (see “Mo-
bile CPU” on page 3 - 17).

5. Click OK to restart the computer if
prompted to do so.

1. Click Start (menu) > Run... USB 2.0 (Win2000)

2. Navigate (Browse..)‘ to Navigate The USB 2.0 driver is only required for Model
(Browse..) to D:\Drivers\Speed- C (sec “USB Port Type” on page 1 - 7)
Step\(Your language)\Disk1\Setup.exe ’
and click OK.

1. Click Start (menu) > Run...

Navigate (Browse...) to D:\Driv-
ers\USB20\Setup.exe and click OK.
Click Yes > Next > Next > Yes > OK.
Select “Print to File” > OK.

Click Finish to complete the setup.

3. Click Next > Yes.

4. Click Finish to restart your computer
when prompted.

5. Click Start (menu), point to Settings and
click Control Panel. Double-click the
Power Options (icon) and then choose
your settings on Intel SpeedStep tech-
nology (tab).

s W

. |
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Windows XP Audio (WinXP)
"l'"his‘section‘ covers dri.ver and utility installa- é Sgﬁfg:::{;g?&gg); t(I){ll;l:l\.i.)riv-
tion instructions for Windows XP. ers\AUDIO\Setup.exe.and click OK.
. . 3. To continue click Next.
p Chipset (WinXP) 4. Click Finish to restart Windows when the
1. Click Start (menu) > Run... Audio Setup box appears.
2. Navigate (Browse..) to D:\Driv- 5. Go to the Sounds & Audio Devices con-
ers\CHIPSET\Setup.exe and click OK. trol panel (Start Menu and point to Set-
3. When the Setup screen appears click tings and click Control Panel then
Next > Yes > Next. double-click the Sounds & Audio
4. Click Finish. Devices icon).
5. The driver is now installed. Note: 1f you are in the Category View

choose Sounds, Speech, and Audio
Devices > Sounds and Audio
Devices.

Click the Audio tab.

Click Advanced in the Sound Playback

Menu.

8. Under Speaker Setup select 5.1 Sur-
round Sound Speakers from the pull-
down menu and click OK > OK to close.

N
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Modem (WinXP)

1.

Windows XP 4 - 23

If you can see the My Computer icon on
your desktop (if you cannot see the My
Computer icon go to step 2) click on it
once to select it, then right-click it to
make the sub-menu appear and scroll
down to Properties and click on it (go to
step 3).

If you cannot see the My Computer icon
click Start (menu), then point to (but
don’t click just highlight it) My Compu-
ter. Right-click it to make the sub-menu
appear and scroll down to Properties and
click on it (go to step 3).

Click the Hardware (tab), then click
Device Manager (button).

Click “+” next to Other Devices (if its
sub-items are not shown).

Double-click PCI Modem and click
Reinstall Driver (button).

When the Hardware Update Wizard
appears, click “Install from a list or spe-
cific location (Advanced)” then click
Next.

10.

Drivers & Utilities

Select “Search for the best driver in
these locations:” and select ONLY
“Include this location in the search:”.
Navigate (Browse...) to D:\Driv-
ers\Modem\WINXP and click OK (but-
ton), then click Next.

Click Finish and close the open win-
dows.

Your modem is now ready for dial-up
configuration.

4

Modem Country Selection

Be sure to check if the modem country selec-
tion is appropriate for you (Control Panel >
Phone and Modem Options).
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LAN (WinXP)

Under Windows XP you have the option to use
the built-in network driver, or install the driver
as per the following procedure.

1. Ifyou can see the My Computer icon on
your desktop (if you cannot see the My
Computer icon go to step 2) click on it
once to select it, then right-click it to
make the sub-menu appear and scroll
down to Properties and click on it (go to
step 3).

2. Ifyou cannot see the My Computer icon
click Start (menu), then point to (but
don’t click just highlight it) My Compu-
ter. Right-click it to make the sub-menu
appear and scroll down to Properties and
click on it (go to step 3).

3. Click the Hardware (tab), then click
Device Manager (button).

4. Click “+” next to Network Adapters (if
its sub-items are not shown).
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Double-click Realtek RTL8139 Family
PCI Fast Ethernet NIC and click the
Driver tab.

Click Update Driver (button).

When the Hardware Update Wizard
appears, click “Install from a list or spe-
cific location (Advanced)” then click
Next.

Select “Search for the best driver in
these locations:” and select ONLY
“Include this location in the search:”.
Navigate (Browse...) to D:\Driv-
ers\LAN\winxp and click OK (button),
then click Next.

10. Click Finish, and close the window.



Video (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Driv-

3,
4,

ers\VIDEQO\Setup.exe and click OK.

To continue press Next > Yes > Express.
Click Finish to restart the computer when
prompted.

TouchPad (WinXP)

l.
2.

kAW

Windows XP 4 - 25

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\touchpad\WINXP\Setup.exe and
click OK.

Choose the language you prefer.

To continue click Next > Next > Next.
Click Finish to restart the computer when
prompted.

You may then configure your TouchPad
as outlined in “ZTouchPad and Buttons”
on page 2 - 25.

Drivers & Utilities

Hot-Key (WinXP)

1.
2.

nbkw

Click Start (menu) > Run...

Navigate (Browse..) to D:\Driv-
ers\KBC_AP\CNKO001.exe and click
OK.

Choose the language you prefer.
Click Next.

Click Finish to restart the computer when
prompted.

You may then configure your Hot-key
Buttons as outlined in “Hot-Keys” on
page 2 - 19.
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Auto Mail (WinXP)

1.
2.

3,
4,

e

Click Start (menu) > Run...

Navigate (Browse..) to D:\Drivers\Auto-
mail\setup.exe. and click OK.

To continue click Next > Next.

Click Finish when the Setup Complete
box appears.

Restart the computer.

You may run and configure the program
from the Start (menu). Point to Pro-
grams (or Auto Mail Checker) and click
Auto Mail Checker.

You may then access the program settings
through the icon in the taskbar. For fur-
ther details see “Auto Mail Checker” on
page 2 - 8.
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Wireless LAN (WinXP)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Driv-
ers\WLAN\GW-LANSetup.exe and
click OK.

3. Click Next > Next > Yes.

4. Select the appropriate Domain Settings
and click Apply.

5. Click OK to restart the computer if
prompted to do so.

USB 2.0 (WinXP)

The USB 2.0 driver is only required for Model
C (see “USB Port Type” on page 1 - 7).

1. Click Start (menu) > Run...

Navigate (Browse...) to D:\Driv-
ers\USB20\Setup.exe and click OK.
Click Yes > Next > Next > Yes > OK.
Select “Print to File” > OK.

Click Finish to restart the computer when
prompted.

wnhw
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Chapter 5: BIOS Utilities

. BIOS Settings
Overview e
This chapter gives a brief introduction to the computer’s built-in Incorrect settings can
software: cause your system to
malfunction. To correct
. . mistakes, return to
Diagnostics: the POST (Power-On Self Test) Setup and restore the
Setup Defaults with
Configuration: the Setup utility <F9>.

If your computer has never been set up, or you are making important
changes to the system (e.g. hard disk setup), then you should review
this chapter first and note the original settings found in Setup. Even
if you are a beginner, keep a record of the settings you find and any
changes you make. This information could be useful if your system
ever needs servicing.

There is one general rule: Don’t make any changes unless you are
sure of what you are doing. Many of the settings are required by the
system, and changing them could cause it to become unstable or
worse. If you have any doubts, consult your service representative.

. |
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Important BIOS Settings

Generally speaking you should not have to adjust any of the BIOS
settings as they will already be set for your computer. However the
following is a quick reference to the most important settings you may
need to change at some point.

Table 5 - 1 Option Page # Purpose
Important BIOS

Settings

Specify’s the order of the devices on which
Boot 5-18 the computer searches for an Operating Sys-
tem as it starts up.

To allow the computer to boot from a network see “Configuring the
Network Boot Protocol” on page 5 - 15.

.|
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The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds
to conduct a POST, including a quick test of the on-board RAM.

As the POST proceeds, the computer will tell you if there is anything
wrong. If there is a problem which prevents the system from booting,
it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the
system will load the operating system. Once that starts, you can’t get
into Setup without rebooting.

.|
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BIOS Utilities
POST Screen

Figure 5 - 1 Phoenix Bios 4.0 Release 6.0
POSt Screen Copyright 1985 - 2001 Phoenix Technologies Ltd.
All Rights Reserved o

T07 BIOS Released 01/15 2002

KBC/EC Firmware Revision: 00. 0.3

CPUID is OFO0Ah which is

MCH Revision ID is 04 which is BO stepping
ICH Revicion ID is 02 which is Bl stepping

CPU = Intel(R) Pentium(R) 4 CPU 1500MHz 9
637K System RAM Passed
126M Extended RAM Passed
/ 256K Cache SRAM Passed
System BIOS shadowed e
64M Video RAM Passed
System BIOS shadowed
5 ] Video BIOS shadowed
1.BIOS information Fixed Disk 0:IC25N020ATDAO04-0
2.CPU type ATAPI CD-ROM: SAMSUNG CD-ROM SN-124
3.Memory status Mouse Intialized

4 HDD identification
notice
5.Enter Setup prompt

appears only during <F2> to enter SETUP 6
POST

Post Screen

5 - 4 POST Screen
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Failing the POST

Errors can be detected during the POST. There are two categories,
“fatal” and “non-fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something
seriously wrong with your system. Take the computer to your service
representative or authorized service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message
identifying the problem (make a note of this message!) followed by
the prompt:

*  Press <FI1> to resume,
+ <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without
the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If
you still get an error message after you change the setting, or if the
“cure” seems even worse, call for help.

. |
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The Setup Program

The Phoenix Setup program tells the system how to configure itself
and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST.
The prompt (“Press F2 to Enter Setup”) seen in Figure 5 - 1 is usu-
ally present for a few seconds after you turn on the system. If you get
a “Keyboard Error” (usually because you pressed F2 too quickly)
just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete
combination and then hold down F2 when prompted. Sefup’s main
menu will appear.

.|
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Setup Screens

The following pages contain additional advice on portions of the /

Setup which are most relevant under normal use.
Setup Menus

Along the top of the screen is a menu bar with five (5) menu head- The Setup menus

. : shown in this section
ings. When you select a heading, a new screen appears. Scroll e e

through the features listed on each screen to make changes to Setup. Your computer's men-
us will indicate the con-
figuration appropriate
for your model and op-
tions.

Instructions on how to navigate each screen are in the box along the
bottom of the screen. If these tools are confusing, press F1 to call up
a General Help screen. Then use the arrow keys to scroll up or down
this page.

The “Item Specific Help” on the right side of each screen explains
the highlighted item and has useful messages about its options.

If you see an arrow (P>) next to an item, press Enter to go to a sub-
menu on that subject. The sub-menu screen which appears has a sim-
ilar layout but the Enter key may execute a command.

The Setup Program 5 - 7
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Main Menu

Figure 5 - 2 : 114
. PhoenixBIOS Setup Utility
Main Menu .
Main Advanced Security Boot Exit
Item Specific Help
[:01:05]
System Date [12/23/2001]
<Tab>, <Shift Tab>, or
Legacy Diskette A: [1.44/1.25 MB 3%/,"] <Enter> selects field.
PPrimary Master [40008MB]
P Secondary Master [CD-ROM]
»Secondary Slave [None]
System Memory: 640 KB
Extended Memory: 129536 KB
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @9 = midnight; 13 =
1 pm). If you can change the date and time settings in your operating
system, you will also change these settings. Some applications may
also alter data files to reflect these changes.
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Legacy Diskette A: (Main Menu)

This control enables the floppy disk drive. /
Primary Master (Main Menu) Switching Hard Disks
Pressing Enter under opens the sub-menu to configure the main IDE Every time you install a

HDD which fits into the computer’s HDD bay. Sr:zeggr':p:taezd itdsiﬁlgu:g

be (re)configured, un-
Type (Main Menu >Primary Master) less Auto is selected.
This setting has several options for choosing which method Setup

will use to detect the hard disk:

The Auto feature may
provide a different set
of parameters for the
* Auto (Default setting) - This allows Setup to determine the hard disk’s same hard disk at dif-

type and other information when you press Enter. It automatically ferent times. However,

loads the information into the BIOS. it shou_ld be reconfig-
ured with the same pa-

. Nonf: - No hard disk is installed. With this optlpn, the system will rameters you got the
require a removable disk to supply the bootup information. first time. If you use a
» User - This allows you to fill in the Cylinders, Heads and Sectors/ different set of param-
Track fields. It automatically calculates “size” based on this informa- eters, it may be impos-

tion. The numbers for all these fields should be printed on the hard disk sible for you to read
itself, or in its accompanying documentation. 2:1syk data on the hard
* Other ATAPI - Removable disk drive is installed. '
* CD-ROM drive.
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Note: For future use, and as a precaution, make a record of the hard
;Q; disk’s original configuration.

LBA Warning LBA Mode Control (Main Menu >Primary Master>LBA Mode Con-
If you enable LBA trol:)
:"g%e ;‘;r :urza’gcﬂif If your hard disk is larger than 528MB (unformatted capacity), en-
’ able this control. The “Auto” Type setting enables this setting if the

able it each time you o
use the same hard disk is large enough.
disk. If you don’t you
may encounter read/
write errors.

4

When to Use LBA

The “standard” or ATA mode of “seeing” HDD'’s is inadequate for drives
larger than 528MB. LBA mode corrects this and allows for hard disks up

to 128GB. ATA and LBA modes overlap. So if LBA mode is not activated
when an HDD is first formatted, sections may not be readable under the
LBA system. (This does not matter with 528 MB or smaller HDD'’s.) If
you're using an HDD not formatted using LBA mode, do not use the “Auto”
setting.

. |
5 - 10 Main Menu
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32 Bit I/O (Main Menu >Primary Master)

Most new hard disks can support this higher rate. If yours can’t, the
“Enabled” setting may slow down the system. Enables 32-bit com-
munication between CPU and IDE card. Requires PCI or local bus.

Primary Slave, Secondary Master & Secondary Slave (Main Menu)
These lines show the secondary IDE devices, either CD devices,
HDDs or nothing (if the storage tray is installed in the Device Bay).

Main Menu 5 - 11
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Advanced Menu

Figure 5 - 3 PhoenixBIOS Setup Utility

Advanced Menu Advanced Security Boot Exit

Item Specific Help

»Intel Developed Advanced Menu

P I/0 Device Configuration Select the size of the
Graphics Aperture for
116 Mbj the AGP video device.

Reset Configuration Data: [No]

Battery Low Beep: [WinXP]
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

Intel Developed Advanced Menu

Items in this menu allow you to control advanced features of the
computer’s operation, including power saving features. If you are
unsure of the particular settings in this sub-menu then these are best
left to the defaults (see “Advanced Menu > Intel Developed Ad-
vanced Menu” on page 5 - 14).
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1/O Device Configuration (Advanced Menu)

The sub-menus under this line include options to configure the Par-
allel (Printer) port and Serial Port B (Infrared). These can be left
to the default settings, however you may wish to use certain devices
(e.g. a printer) which require settings to be adjusted accordingly.
Check the documentation for any such devices to see what settings
are required.

Graphics Aperture (Advanced Menu)

The AGP aperture is an area of system RAM reserved for use by the
AGP card for storing textures if it needs to. The RAM is available for
use by the system as normal if not used by the graphics card.

Battery Low Beep (Advanced Menu)
Choose “Enabled” to set the audible warning when your PC battery
is low.

BIOS Utilities

4

Graphics Aperture

This feature was im-
port for older graphics
cards in the past,
which typically had
only 4MB or 8MB of
onboard memory.
However, most mod-
ern  AGP  graphics
cards have 32MB or
more, so this setting is
now of much less im-
portance. In most cas-
es you are unlikely to
need to set the AGP
aperture at more than
32MB.

Advanced Menu 5 - 13
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Figure 5 -4
Intel Developed
Advanced Menu

5 - 14 Advanced Menu

Advanced Menu > Intel Developed Advanced Menu

PhoenixBIOS Setup Utility

Intel Developed Advanced Menu

Item Specific Help

» ACPI Table/Features Control Sub-Menu
Throttle Duty Rate:
Clock Chip Initialization:

USB - Controller:

[50.0%]
[Enabled]
[Disabled]

[Enabled

Disable shadowing of
the PXE Oprom if you
need to test other
oproms, like Adaptec
SCSI, because there
is not enough UMB
space for both.

Help Select Item
Exit Select Menu

Change Values

Setup Defaults

Select PSub-Menu Save and Exit

USB Controller: (Advanced Menu>Intel Developed Advanced

Menu)

Enable or disable USB devices (only available in Models A & B).

PXE Oprom:(Advanced Menu>Intel Developed Advanced Menu)
Choose “Enabled” to get the option to boot from a network. The Re-
altek Boot Agent Menu (see “Configuring the Network Boot Proto-
col” on page 5 - 15) allows you to configure the network protocol.



Configuring the Network Boot Protocol

Realtek RTK8139 (A/B/C)/RTL8130 Boot Agent
Press Shift-F10 to configure

Realtek RTL8139(A/B/C)/RTL8130 Boot Agent
Configuration Menu v2.11

Network Boot Protocol

Boot Order Int 15h
Show Config Message Enable
Show Message Time 3 Seconds

<Space> <Enter> <F4>
Change Value Next Option Save/Quit

After enabling the network boot option from the Advanced menu
(see “PXE Oprom:(Advanced Menu>Intel Developed Advanced
Menu)” on page 5 - 14) you may configure the settings at startup.
When you see the message pictured @), press and hold the Shift and
F10 keys to get to the Boot Agent Configuration Menu @. Save the
settings to automatically boot from the network at startup.

BIOS Utilities

Figure 5 -5
Boot Agent Menu

4

Enabling Network
Boot

Go to the Intel Devel-
oped Advanced Menu.

Set the PXE Oprom
option to Enabled.

Save the changes and
exit.

At startup, press and
hold the Shift and F10
keys.

Configure the network
protocol.

Save the settings to
automatically boot
from the network.
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Security Menu

F igure 5-6 PhoenixBIOS Setup Utility
Security Menu | ... [
Item Specific Help
Supervisor Password Is: Clear
Supervisor Password
[Enter]| controls access to the
setup utility.
Fixed disk boot sector: [Normal]
Password on boot: [Disabled]
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit
Security Menu

The changes you make here affect the access to the Setup utility it-
self, and also access to your machine as it boots up after you turn it
on. These settings do not affect your machine or network passwords
which will be set in your software OS.
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Set Supervisor Password: (Security Menu)
Set a password for access to the Setup utility (this will not affect ac- ﬁ
cess to the computer OS, only the Sefup utility).

Password Warning

Password on boot: (Security Menu) If you choose to set a
If “Enabled” is chosen, the supervisor password as set above will be boot password, NEV-
required to boot the system. Only users who enter a correct password S EEES ES LS

« s o : : word.

can.boqt t‘tle .system”(see Warning” in the sidebar). The default FEEeE e
setting is “Disabled”. this could be serious. If
you cannot remember

Fixed disk boot sector: (Security Menu) CTONTT PR [PEBEEI
If you choose “Write Protect” this will protect against viruses being [ et it St iy
you choose “Write Protect” this will protect against viruses being BRI
written to the hard disk boot sector (this is not a substitute for install- lose all of the informa-
ing an anti-virus program - see “Viruses” on page 7 - 5). tion on your hard disk.
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Boot Menu

F gure 5-7 PhoenixBIOS Setup Utility

BOOT Menu

Item Specific Help

Keys used to view or
Hard Drive configure devices:
CD-ROM Drive <Enter> expands or
collapses devices with
a + or -

<Ctrl+Enter> expands
all

<Shift+1l> enables or
disables a device.

<+> and <-> moves the
device up or down.

<n> May move removable
device between the Hard
Disk or Removable Disk
<d> Remove a device
that is not installed.

Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit
Boot Menu

When you turn the computer on it will look for an operating system
(e.g Windows 2000) from the devices listed in this menu, and in this
order. If it cannot find the operating system on that device, it will try
to load it from the next device in the order specified in the Boot
Menu.

5 - 18 Boot Menu



Boot devices usually are hard drives, floppy drives and CD-ROMs.

When you specify a device as a boot device on the Boot Menu, it re-
quires the availability of an operating system on that device. Most

PCs come with an operating system already installed on hard-drive
C:

If you wish to boot from a CD-ROM you will need to add it to the
boot order. As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM Drive
3. Hard Drive

In everyday use you will usually boot from the Hard Drive, however
there may be occasions when it is advantageous to boot from a flop-
py disk or CD-ROM.

To get the option to run the Realtek Boot Agent Menu, which allows
the option to boot from a network, see “Configuring the Network
Boot Protocol” on page 5 - 15.

BIOS Utilities
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Exit Menu

Figure 5 -8
Exit Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit _

Item Specific Help

Exit Discarding Changes Exit System Setup and
Load Setup Defaults save your changes to
Discard Changes CMOS .

Save Changes

Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit
Exit Menu

Choosing to “Discard Changes” or “Exit Discarding Changes”
will wipe out any changes you have made to the Setup. You can also
choose “Load Setup Defaults” which will return the Setup to its
original state and erase any previous changes you have made in a
previous session.
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Chapter 6: Upgrading The Computer

Overview

This chapter contains the information on upgrading the computer.
Follow the steps outlined to make the desired upgrades. If you have
any trouble or problems you can contact your service representative
for further help. Before you begin you will need:

* A small crosshead or Phillips screwdriver
* A small regular screw driver
* An antistatic wrist strap

Before working with or repairing the internal components you will N/

need to wear an antistatic wrist strap to ground yourself because stat- ’Q\

ic electricity may damage the components. Warranty Warning

The chapter includes: Please check with your
service representative

* Upgrading the Device in Bay One before undertaking any

» Upgrading the Hard Disk Drive upgrade procedures to

» Upgrading the Device in Bay Two e E ISl YD
your warranty.

Please make sure that you review each procedure before you
perform it.

. |
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When Not to Upgrade

These procedures involve opening the system’s case, adding and
sometimes replacing parts.

You should not perform any of these upgrades if:

* your system is still under warranty or a service contract
* you don’t have all the necessary equipment

* you’re not in the correct environment

* you doubt your abilities

Under any of these conditions, contact your service representative to
purchase or replace the component(s).

6 - 2 Overview
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Upgrading the Device in Bay One

The interchangeable device installed in Bay One will depend on
what configuration you purchased. If you wish to change or upgrade
this device follow this procedure.

1. Turn the computer OFF.
. Place the computer on a clean, stable surface and turn it over.
3. Locate the release latch @ (Figure 6 - 1) for the bay one
device.
4. Slide the release latch towards the unlock symbol and hold it in
position.

B — | Figure 6 - 1

Bay One Release

l

Upgrading the Device in Bay One 6 - 3



Upgrading The Computer

5. With the release latch held in position, slide the device out
slightly, then lift it up out of the computer.

6. Hold the release latch in the unlocked position and hold the
new /replacement device as illustrated in (Figure 6 - 2).

7. Gently push the new /replacement device down and slide for-
ward until the latch snaps back in to position (make sure it is
tightly locked).

Figure 6 - 2
Remove and Insert
Device

6 - 4 Upgrading the Device in Bay One
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Upgrading the Hard Disk Drive

The hard disk drive is used to store your data internally in the com-
puter. It is mounted in a removable case under Bay One (which con-
tains your interchangeable device) and can be taken out to
accommodate other 2.5” IDE hard disk drives with a height of 9.5
mm. The system supports the following:

Master mode IDE
PIO mode 4
ATA-33/66/100
Ultra DMA

Upgrading the Hard Disk Drive 6 - 5
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Removing the Hard Disk

1. Turn the computer OFF.

2. Place the computer on a clean, stable surface and turn it over.

3. Remove the device in Bay One (see “Upgrading the Device
in Bay One” on page 6 - 3).

Figure 6 - 3
Hard Disk Removal

4. Remove screw @ (Figure 6 - 3).
5. Slide the HDD assembly forward and up, then out of the com-
puter.
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6. Remove screws @ - @ (Figure 6 - 4) from the assembly, and
slide the hard disk out of the case.
7. Just reverse the removal procedure to install the new HDD.

Figure 6 - 4
Hard Disk Out
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2N\
2 &

Software
HDD System

Warning Allow the system to auto-detect the new HDD, or if necessary, run
the Setup Utility in the BIOS to customize the system (see “Main
Menu” on page 5 - 8).

Some Things to Watch Out For

New HDDs are blank.
Before you begin make
sure:

WCEREIELEE SRR Setting Up a New HDD

any data you want to . . L. . .

keep from your old Follow your operating system’s installation instructions and install
HDD. all necessary drivers and utilities as outlined in “What to Install” on
You have all the CD-

ROMs and FDDs re- paged - 2.
quired to install your
operating system and
programs.

If you have access to
the internet, download
the latest application
and hardware driver
updates for the operat-
ing system you plan to
install. Copy these to a
removable medium.
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Upgrading the Device in Bay Two

If you need to upgrade or replace the device in Bay Two then follow
this procedure, however take note of the warranty warning on the
right.

S

Warranty Warning

1. Turn the computer OFF.
Place the computer on a clean, stable surface and turn it over.

3. Remove screw @ (Figure 6 - 5). Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

LLCULERCLETRCTCLTTLUTTTTYLS

W

Figure 6 - 5
Bay Two Screw
Location

.|
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4. Apply gentle, but firm, pressure at point @ (Figure 6 - 6) and
slide the device out of the computer.
5. Just reverse the removal procedure to install the new device.

Figure 6 - 6
Bay Two Device
Removal

6 - 10 Upgrading the Device in Bay Two
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Upgrading the System Memory

The computer has two memory sockets for 200-pin PC-200/266MHz
DDR Small Outline Dual In-line Memory Modules (SO-DIMM).
The main memory can be expanded up to 1024MB, and accepts 128/
256/512MB modules.

The total memory size is automatically detected by the POST routine
once you turn on your computer.

To upgrade the memory in your notebook please perform the follow-
ing steps:

Remove the keyboard.

Remove a memory module (if present) where necessary.
Insert a new memory module.

Replace the keyboard.

Upgrading the System Memory 6 - 11
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Removing the Keyboard

1. Turn off the computer.

2. Press the two keyboard latches at the top of the keyboard to
elevate the keyboard from its normal position as in Figure 6 - 7
(you may need to use a small screwdriver to do this).

Figure 6 - 7
Keyboard Removal
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3. Carefully lift the keyboard up and out, being careful not to bend
the keyboard ribbon cable @ (Figure 6 - 7).

4. Remove screws @ and @ (Figure 6 - 7) from the shielding
plate, and lift the plate up off the computer.
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2 &

Contact Warning

5. Locate the Memory sockets @ and @ (Figure 6 - 8).

Be careful not to touch
the metal pins on the
module’s  connecting

edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

6. If there is a module currently installed which needs to be

upgraded/replaced then remove it. Figure 6 - 8

7. Gently pull the two latches (@and @ in Figure 6 - 8) on the Memory Sockets
memory socket toward the sides of the computer, as indicated
in Figure 6 - 8.
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8. The module @ (Figure 6 - 9) will pop-up, and you can remove
it.

9. Insert a new module holding it at about a 30° angle and fit the
connectors firmly into the memory slot.

Figure 6 - 9
Memory Removal

10. The module will only fit one way as defined by its pin alignment.
Make sure the module is seated as far into the slot as it will go.
DO NOT FORCE IT; it should fit without much pressure.

11. Press the module down towards the mainboard until the slot
levers click into place to secure the module.

.|
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12. Replace the shielding plate and the 2 screws (Figure 6 - 7 on
page 6 - 12).

13. Replace the keyboard by insuring the five tabs at the base of
the keyboard fit into place (you will find these under the Fn,
Spacebar (2), Ctrl and arrow keys - see Figure 6 - 10).

Figure 6 - 10
Keyboard Tabs
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\ Keyboard Tabs/

14. Carefully press the front of the keyboard down so that the two
latches at the front of the keyboard lock down again.

15. Restart the computer.

16. During the startup process, the BIOS will register the new
memory configuration.

u
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Upgrading the Processor

/Zl\ If you want to upgrade your computer by replacing the existing pro-
WLEITET S LR cessor with a faster/new one you will need to contact your customer
The CPU is not a user service representative. We recommend that you do not do this your-
serviceable part. self, since if it is done incorrectly you may damage the processor or

Opening the CPU : . . _
compartment, o ac. mainboard Appendix A: page A-8.
cessing the CPU in
any way, may violate
your warranty.

2 &

CPU Speeds & Power Supplies - Model A

90W power adapters for Model A CPUs of 2.0/2.2/2.4GHz will not supply

enough power for CPUs below these speeds.

See for information on processors, and
for specific power infor-

mation.

.|
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Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consult-
ing the service center, you may want to try to solve the problem your-
self. This chapter lists some common problems and their possible
solutions. This can’t anticipate every problem, but you should check
here before you panic. If you don’t find the answer in these pages,
make sure you have followed the instructions carefully and observed
the safety precautions in the preface. If all else fails, talk to your ser-
vice center. You should also make a record of what happened and
what remedies you tried.

Of course, if something goes wrong, it will happen at the most incon-
venient time possible, so you should preview this section just in case.
If, after you’ve tried everything, and the system still won’t cooperate,
try turning it off for a few minutes and then rebooting. You will lose
any unsaved data, but it may start working again. Then call your ser-
vice representative.

. |
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7 - 2 Basic Hints and Tips

Basic Hints and Tips

Many of the following may seem obvious but they are often the so-
lution to a problem when your computer appears not to be working.

*Power:

eConnections:

*Power Savings:

eConnections:

Is the computer actually plugged into a work-
ing electrical outlet? If plugged into a power
strip, make sure it is actually working.

Check all the cables to make sure that there are
no loose connections anywhere.

Make sure that the system is not in Hibernate
or Standby mode by pressing the power button
for less than 4 seconds (the Power Button LED
will flash green while in Standby mode, in
Hibernate mode it will be off).

Check the brightness of the screen by pressing
the Fn + F8 or F9 keys to adjust the brightness
(see “Opening the LCD” on page 3 - 2).
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*Display Choice:  Press Fn + F7 to make sure the system is not
set to “external only” display (see “Attaching a
Monitor (CRT)” on page 3 - 8).

*Boot Drive: Make sure there are no floppy disks in the
drive when you start up your machine (this is a
common cause of the message “Invalid system
disk - Replace the disk, and then press any
key”).

.|
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Backup and General Maintenance

* Always backup your important data, and keep copies of your OS and
programs safe, but close to hand. Don’t forget to note the serial num-
bers if you are storing them out of their original cases e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you
can. You may schedule these programs to run at times when you are
not using your computer. You can use those which are provided free
with your OS, or buy the more powerful dedicated programs to do so.

*  Write down your passwords and keep them safe (away from your com-
puter). This is especially important if you choose to use a Startup
password for the BIOS (see “Security Menu” on page 5 - 16).

» Keep copies of vital settings files such as network, dialup settings,
mail settings etc. (even if just brief notes).

7 - 4 Backup and General Maintenance
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Viruses

» Install an Anti-Virus program and keep the definitions file (the file
which tells your program which viruses to look for) up to date. New
computer viruses are discovered daily, and some of them may seriously
harm your computer and cause you to lose data. Anti-Virus programs
are commercially available and the definitions file updates are usually
downloadable directly from the internet.

» Be careful when opening e-mail from sources you don’t know. Viruses
are often triggered from within e-mail attachments so take care when
opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware
of files from people you know as the virus may have infected an
address book and been automatically forwarded without the person’s
knowledge.

* Keep a “Boot Floppy Disk” (this disk provides basic information
which allows you to startup your computer) handy. You may refer to
your OS’s documentation for instructions on how to make one, and
many Anti-Virus programs will also provide such a disk (or at least
instructions on how to make one).

. |
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e Upgrading and Adding New Hardware/
s Software

Warranty
IQ:iS:aLtjnllj note ;:?tr * Do not be tempted to make changes to your Windows Registry unless
Opening this compart- you are very sure of what you are doing, otherwise you will risk
ment may violate your severely damaging your system.
warranty.
e e . Pleasg don’t open your computer or undertake any repair or upgrade
ing with the HDD may work if you are not comfortable with what you are doing.
also violate your war-
ranty. » Read the documentation. We can assume, since you are reading this,
that you are looking at the computer’s manual, but what about any new
peripheral devices you have just purchased? Many problems are
caused by the installation of new hardware and/or software. Always
refer to the documentation of any new hardware and/or software, and
pay particular attention to files entitled “READ ME” or “READ ME
FIRST”.

*  When installing a new device always make sure the device is powered
on, and in many cases you will need to restart the computer. Always
check that all the cables are correctly connected.
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» Make sure you have installed the drivers for any new hardware you
have installed (latest driver files are usually available to download
from vendor’s websites).

» Thoroughly check any recent changes you made to your system as
these changes may affect one or more system components, or software
programs. If possible, go back and undo the change you just made and
see if the problem still occurs.

* Don’t over complicate things. The less you have to deal with then the
easier the source of the problem may be found; Example - if your com-
puter has many devices plugged into its ports, and a number of pro-
grams running, then it will be difficult to determine the cause of a
problem. Try disconnecting all of the devices and restarting the com-
puter with all the peripheral devices unplugged. A process of elimina-
tion (adding and removing devices and restarting where necessary) will
often find the source of a problem, although this may be time consum-
ing.

Upgrading and Adding New Hardware/Software 7 - 7
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Power
Problem Possible Cause Possible Solution
You turned on the The battery is missing or Check the battery bay, make sure the battery is
power but it doesn’t incorrectly installed. present and seated properly (the design of the battery
work. only allows it to go in one way). Make sure there’s
(The battery status nothing interfering with the battery contacts.
LED {11, doesn’t
light up.)
The battery status Low battery Plug in the AC power source. If the computer doesn’t
7 LED ), is blinking start up immediately, turn it off then on again.
yellow.
The various LEDs The suspend key Press Fn + Suspend (F4), or other configured key
light up, but no combination, Fn + Suspend combination. Wait a few moments before trying this
picture appears. (F4), or other configured key control again.
combination, has been
toggled.
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Problem Possible Cause

Possible Solution

You are losing
battery power too
quickly.

The battery does not fully
charge because of prolonged
inactivity.

The battery is too hot.

N A
Z S

Overheating

To prevent your computer from overheating make sure
nothing blocks the vent while the computer is in use.

The system is using too much
power.

4

Battery Charging

Make sure the battery is totally used up before recharg-

ing, and make sure you recharge the battery to full ca-
pacity each time you recharge (see “Battery” on page 2
-3).

Allow the battery to cool. If this problem persists, make
sure the vents aren’t blocked and the computer isn’t
sitting on a thermal surface. Make sure you're using
the correct adapter.

If your OS has a Power Management/Power Options
scheme (see “Enabling Power Management/
Options” on page 3 - 18) check its settings. You may
also be using a PC card device which is drawing a lot
of power.
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Problem

Possible Cause

Possible Solution

The notebook feels
too hot.

The system is using too much
power or is not properly
ventilated.

Reduce the computer’s power consumption. Make
sure the notebook is properly ventilated and the fan
port is not blocked. If this doesn’t cool it down, put the
system into Suspend mode or turn it off for an hour.

The battery pack will
not charge.

2N
1§

Overheating

To prevent your computer

from overheating make sure
nothing blocks the vent
while the computer is in use.

The battery pack is exposed to an excessively hot or
cold environment.

Place the battery in a suitable environment and after it
returns to normal temperature try again.

The battery may be bad and may need to be replaced,
contact your service center for more details.

The battery pack will
not charge and the
charge indicator light
is off.

The battery is already fully
charged and the indicator
light is broken.

The battery may be bad and may need to be replaced,
contact your service center for more details.

A beeping sound is
heard and the low-
battery indicator is

on.

The battery power is nearly
used up.

Connect the AC adapter to your computer.
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Troubleshooting

Problem

Possible Cause

Possible Solution

A beep isn’t heard
when the low-battery
indicator turns on, or
the gauge indicates
power is less than
10%.

The battery power is nearly used up and the volume
control may be turned down. Adjust the volume control
and connect the computer with the AC adapter.

Actual battery
operating time is
shorter than
expected.

The battery has not been fully
discharged before being
recharged.

Power Management/Power
Options have been disabled.

A peripheral device or PC
card is consuming a lot of
power.

Previously the battery was
given only a partial charge.

Make sure the battery is fully discharged and recharge
it completely before reusing.

Go to the Control Panel in Windows and re-enable
the options.

Turn off the unused device to save power.

Always fully charge the battery after it has been totally
used up.
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Display

Problem

Possible Cause

Possible Solution

Nothing appears on
screen.

The LED power indicator,
D+, is blinking green.

The screen controls need to
be adjusted.

The computer is set for a
different display.

The screen saver is
activated.

The system is in a power saving mode. Toggle the
suspend key combination, Fn + F4 Suspend (see
“Function Keys” on page 2 - 22).

Toggle the screen control key combinations Fn + F8
and F9 (see “Opening the LCD” on page 3 - 2). If
you're connected to an external monitor, make sure it's
plugged in and turned on. You should also check the
monitor’s own brightness and contrast controls.

Toggle the screen display key combination, Fn + F7.
(see “Attaching a Monitor (CRT)” on page 3 - 8). If
an external monitor is connected, turn it on.

Press any key or touch the TouchPad to return to your
display.

The screen is
flickering.

The vertical refresh rate is
insufficient on your external
monitor.

Avoid using the Simultaneous display mode. Use LCD
only or CRT only.

Switch to a lower resolution and/or fewer colors.

Adjust the refresh frequency in the display controls
(see “Vertical Refresh Rate” on page 3 - 8).
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Troubleshooting

Problem Possible Cause Possible Solution

The screen images The screen controls need to Toggle the screen control key combinations Fn + F8
aren’t clear. be adjusted. and F9 (see “Opening the LCD” on page 3 - 2).

The viewing angle of the LCD | Adjust the position of the LCD. LCDs are designed to
is bad. be viewed “straight on”. If the angle is wrong, you may
see glare from the screen’s backlight.

The screen is dirty (the Clean the screen using a soft, clean dry cloth. Many
screen images are blurry). cleaning solutions can damage the LCD surface so
you should follow the precautions outlined in the
Preface. Try to avoid touching the screen itself. Even
the cleanest hands can leave oils which attract
contaminants.

The screen is suffering from This problem is usually associated with external CRT
burn-in (the screen has ghost | monitors. Use power saving options (see “Monitor
images, even when it’s off). Standby” on page 3 - 19) to turn off the LCD. You can
also use a screen-saver which can help protect an
attached monitor.
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Troubleshooting

Hard Disk Drive (HDD)

Problem Possible Cause Possible Solution
The computer takes Data saved on the hard disk Please operate the scan disk or disk defragmenter to
longer during drive may be lost or check for any lost or damaged data.
Startup. damaged.

The computer is waking up
from Hibernate mode.

Boot Password

Problem Possible Cause Possible Solution

If you choose to set a boot password, NEVER forget
your password. The consequences of this could be
serious. If you cannot remember your boot password
you may have to discharge the battery of the CMOS
(contact your service representative) and you may
lose all of the information on your hard disk. See
“Security Menu” on page 5 - 16

You forget the boot
password.

.|
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Troubleshooting

Floppy Disk Drive (FDD)

Problem Possible Cause Possible Solution
The floppy disk drive | The floppy disk is not Format the disk (you may do this by right-clicking the
will not write data to formatted. disk icon in My Computer in Windows and choosing
disk. Format from the menu). Bear in mind that this will

erase all data contained on the floppy disk.

Floppy disks were never intended for long-term data
storage, and have a finite lifespan. Do not store
important files you wish to keep for a long time on
floppy disks. As a general rule it is worth reformatting
floppy disks regularly.

The floppy disk is write- Undo the protection by moving the write-protect tab on
protected. the disk down until it clicks.

There is not enough unused Use a new disk or delete unneeded data.
space available on the disk. —
2 &

Media Warning

Don't try to remove a floppy

disk while the system is ac-
cessing it. This may cause
the system to “crash”.
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Problem Possible Cause Possible Solution
The message The computer is trying to boot | Remove the floppy and insert a correct one, or boot
“Invalid system from an incorrect floppy disk. | from your hard disk or CD. You will need to restart the
disk - Replace the computer.

disk, and then
press any key”
appears.
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Troubleshooting

Audio

Problem Possible Cause Possible Solution
The Audio “DJ” CD The computer is turned ON Check your computer is not turned on (or running in a
Player will not turn (see “Audio “DJ” CD power saving mode), and if it is then shut it down, then
on (nothing appears | Player” on page 1 - 15). toggle the ON/OFF switch on the CD Player.

on the LCD of the

player). 4

Sound Volume Adjustment

How high the sound volume can be set using the volume
control knob depends on the setting of the volume control
within Windows. Click the Speaker icon on the taskbar
to check the setting.

The Volume controls on the Audio DJ player still control
the volume settings if the computer’s operating system is

running.
The sound cannot The volume might be set too Check the volume control in the Sound Control Panel
be heard or the low. in the Windows Toolbar. Check the headphones are
volume is very low. plugged into the correct jack. They should be plugged

into the Headphone-Out jack (see “Headphone-Out
Jack” on page 1 - 23). Check the volume control
settings on the Audio “DJ” player.
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Troubleshooting

CD Device

Problem Possible Cause Possible Solution

The compact disc The compact disc is dirty. Clean it with a CD-ROM cleaner Kit.
cannot be read.

\ A/

26

Media Warning

When manually ejecting a CD/DVD disc, DO NOT use a
sharpened pencil or similar object which may break, and

. become lodged in the hole.

The compact disc The compact disc is not Gently try to remove the disc using the eject hole (see
tray will not open correctly placed in the tray. “Loading Compact Discs” on page 2 - 14).

when there is a disc

in the tray.

| can no longer You have already changed See “DVD Regional Codes” on page 2 - 16.

change region codes | the code the maximum 5
any more using the times.
DVD utility.
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Troubleshooting

Problem Possible Cause Possible Solution
A music compact There may be a problem with | Refer to your operating system manual for more
disc can be read the disc hardware or information on the software and make sure you have
while a data disccan | software. the correct software installed for running video
not. compact discs/DVDs. If the proper software is properly

installed and a problem still exists, contact your
service representative about a possible hardware

problem.
All compact discs The Windows system does Make sure you have the CD-ROM drive properly
cannot be read. not recognize the CD-ROM installed and configured.

drive, or the CD-ROM drive is
not compatible with other
devices.

The CD-ROM drive is dirty. Clean it with a CD-ROM cleaner kit.

There may be a problem with | Refer to your operating system manual for more

the disc hardware or information on the software, and make sure you have
software. the proper software installed for using compact discs.
If the correct software is properly installed, contact
your service center about a hardware problem.
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Troubleshooting

PC Card

Problem Possible Cause Possible Solution
The system cannot The PC card is not inserted Remove the card and reinsert it aligning the PC card
recognize the PC into the socket or inserted with the slot. Push the card in until it locks into place.
card. incorrectly.
The PC card driver is not Please read the documentation which comes with any
installed. new external device, and make sure you install the

driver for it as this will allow you to access any extra
functions which come with your device.

The PC card or card driveris | See Appendix A:“PC Card” on page A-6 to check
not compatible with the the compatibility of your card.
computer’'s OS.
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The PC Card Problem in Windows 98

After installation of Windows 98 or Windows 98 Second Edition, you
may find that the PC cards are not working normally and you may
also notice one or more of the following:

* An exclamation mark appears in the PC card driver in Device
Manager

* PC cards don’t work at all

» PC card controllers are not enumerated

* PC card controllers are disabled on power-up

» PC card controllers are disabled when you resume the computer from
Suspend mode

This is a problem caused by Microsoft Windows 98 (Second Edition).
To resolve the problem, immediately after installing Windows 98SE
install the program file PCL.vxd to update your system driver. The
PCIL.vxd driver is supplied by your computer service representative.
For more information on this, refer to the Microsoft article “CardBus
Device Not Enumerated with TT 14xx or 44xx CardBus Controllers”
(Article ID Q233017) which can be found on Microsoft’s web site.
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7 - 22 PC Card

The PC Card Problem in Windows ME

After you resume your computer from suspend mode and try to use
a program that uses a PCMCIA modem, the Windows message server
(Msgsrv32.exe) may stop responding (hang). Windows-based pro-
grams or Windows itself may then hang. This problem can occur
when you are using Dial-Up Networking to connect to an Internet
service provider and your computer enters Suspend mode or Standby
mode before you disconnect the Dial-Up Networking connection.

This is a problem caused by Microsoft Windows ME (Millennium
Edition). To resolve the problem, immediately after installing Win-
dows ME install the program file PCIL.vxd to update your system
driver. The PCIL.vxd driver is supplied by your computer service rep-
resentative.

For more information on this, refer to the Microsoft article “Comput-
er with PCMCIA Modem Hangs During Suspend Mode” (Q270086)
which can be found on Microsoft’s web site.



Troubleshooting

Keyboard and Mouse

Problem Possible Cause Possible Solution
Unwelcome The NumLock is turned ON Press and release the Fn & NumLk keys.
numbers appear (the LED (i is lit).
when typing.
| have installed a You have not installed the Make sure you read the documentation which comes
new external driver to enable any extra with any new external device, and make sure you
keyboard or mouse functions. install the driver for it as this will allow you to access
but cannot use all of any extra functions which come with your device.

the listed functions.

4

Other Keyboards

If your keyboard is damaged or you just want to make a
change, you can use any standard PS/2 or USB key-
board. The system will detect and enable it automatically.
However special functions/hot keys unique to the sys-
tem’s regular keyboard may not work.

.|
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Troubleshooting

Printer

Problem

Possible Cause

Possible Solution

The printer cannot
be added to the
system or will not
work.

The printer power is off or the
printer is not correctly
connected to the computer.

The printer is not turned on,
or has an internal problem.

There is no paper in the
printer, or the paper is
incorrect for the settings
designated in your software.

The printer driver is not
installed or is configured
incorrectly.

Check all connections and cables and then try to
reinstall the driver.

Make sure the printer is on. You may refer to the
printer’s manual for instructions on printing a “self-test”
page (a “self-test” page will print regardless of
computer connections and is a means of insuring that
the printer is actually working).

Put more paper in the printer (also fan the paper to
make sure it doesn't stick together and cause a paper
jam) and check the paper size matches your
software’s “print” settings.

Check that the printer is properly installed and
configured (correct port etc.). Also check that you
have installed the latest driver compatible with your
OS (updated drivers are usually available for
download from the printer manufacturer’s website).
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Troubleshooting

Problem Possible Cause Possible Solution
The printer is a network All networks are configured differently so please check
printer and it is not properly with your network administrator to get the correct
connected to the network. setup.

The operation mode for the The default operation mode for the parallel port (ECP)
parallel port set in the BIOS | is backward compatible with other operation modes

doesn’t correspond with the used by older printers and will usually not need to be
mode your printer can work changed. However some very old printers may require
with. specific settings. Please check your printer manual to

find out which mode your printer uses. Check that the
settings in the BIOS (see “I/O Device Configuration
(Advanced Menu)” on page 5 - 13) correspond with
those indicated in your printer manual.
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Operation

Problem

Possible Cause

Possible Solution

The system won'’t
start up when the
power button is
pressed.

The Audio “DJ” CD Player is
ON (see “Audio “DJ” CD
Player” on page 1 - 15).

Toggle the ON/OFF switch off the CD Player.

The system never
goes into hibernate
mode.

The system freezes.

The system’s power saving
features have timed-out (the
screen goes dark).

A software conflict made the
system “crash”.

N/
P
Hibernate Mode in
Windows 98SE

Hibernate Mode is not avail-
able in Windows 98SE.

Power Management/Power
Options features are not
enabled.

Use the AC adapter, press the Fn + F4 (Suspend) key
combination, or press the Power Button if no LEDs are
lit.

Consult your OS manual. As a last resort, since you
will lose any unsaved data, try to reboot the system or
if that doesn’t work, turn the computer off and on
again.

See “Enabling Power Management/Options” on
page 3 - 18).
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Problem Possible Cause Possible Solution

The system does not | Suspend Timeout is disabled. | Use one of the Power Management/Power Options
go into suspend or presets.

save to disk when
the battery is low.

The Infrared device The drivers (if supplied with Please read the documentation which comes with any
doesn’t work. the device) are not loaded. new external device, and make sure you install the
driver (if there is one needed) for it as this will allow
you to access any extra functions which come with
your device.

The Infrared settings are not See “Configuring the Infrared Settings for FIR” on

configured correctly. page 3 - 31.

The IrDA port is blocked. Make sure nothing is between your system’s IrDA port
and the destination’s port. The IrDA operates on a
“Line of Sight”.

Support for IrDA/AskIR/FIR The default infrared mode (FIR) is backward

types infrared devices is compatible in supporting IrDA/AskIR devices. This will

disabled. usually not need to be changed, however some

devices may require specific settings. Changes may
be made in the BIOS Setup in the Advanced menu
(see “I/O Device Configuration (Advanced Menu)”
on page 5 - 13).

.|
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Appendix A. Specifications

For help on model identification see “Model Types” on page I - 6.

Processor (Model A)

Intel Pentium®4 - 1.4/1.5/1.6/1.7/1.8GHz (400 MHz front side bus)
CPU Package - (478-pin) FC-PGA2
256KB L2 cache (on die)

Intel Pentium®4 - 2.0/2.2/2.4GHz (400 MHz front side bus)
CPU Package - (478-pin) FC-PGA2
512KB L2 cache (on die)

Processor (Model B)

Intel Mobile Pentium®4 - 1.4/1.5/1.6/1.7/1.8/2.0GHz (400 MHz front
side bus)

CPU Package - (478-pin) Micro-FCPGA

512KB L2 cache (on die)

>"\Z
&
Warranty

The CPU is not a user
serviceable part.
Opening this compart-
ment may violate your
warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.




Warranty

The CPU is not a user
serviceable part.
Opening this compart-
ment may violate your
warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.

Processor (Model C)

* Intel Pentium®4 - 2.26/2.4/2.5/2.53/2.6/2.66/GHz (533 MHz front side
bus)

* CPU Package - (478-pin) FC-PGA2

* 512KB L2 cache (on die)

+ Intel Pentium®4 - 2.0/2.2/2.4GHz (400 Mhz front side bus)
* CPU Package - (478-pin) FC-PGA2
* 512KB L2 cache (on die)

 Intel Celeron - 1.7/1.8GHz (400 MHz front side bus)
* CPU Package - (478-pin) FC-PGA2 package
* 128KB L2 cache (on die)

Core Logic (Models A & B)
* Intel® 845MP+ICH3M chipset

Core Logic (Model C)
* Intel® 845E chipset



Structure
* All-in-one
* Compliant to PC99 standard

Security

» Security (Kensington® Type) Lock Slot
* BIOS Password

Memory

* Two 200Pin SODIMM sockets, PC200/266MHz DDR devices
» Expandable up to 1024 MB (128/256/512MB SODIMM Modules)

BIOS

e One 512KB Flash ROM
e Phoenix BIOS

LCD (Options)

« 141"- XGA  1024x768
« 14.1"- SXGA+ 1400x1050
« 15.0"- XGA  1024x768
« 15.0"- SXGA+ 1400x1050
+ 15.0"- UXGA 1600x1200
« 15.0"- QXGA 2048x1536




Display (Models A & B)

* ATI Mobility Radeon 7500, Integrated AGP™ 4X

+ Integrated 128-bit 2D / 3D Graphics Accelerator-
Advanced HW Acceleration for DVD Playback (Motion Compensa-
tion engine and IDCT)
Fully DirectX 8 Compliant Graphics Engine

* External memory up to 32/64 MB DDR SGRAM on board

* Dual-view Display Monitor

* TV resolution up 1024x768 32bpp

* CRT resolution up to 2048x1536

Display (Model C)

* ATI Mobility Radeon 9000, Integrated AGP™ 4X

* Integrated 128-bit 2D / 3D Graphics Accelerator-
Advanced HW Acceleration for DVD Playback (Motion Compensa-
tion engine and IDCT)
Fully DirectX 8.1 Compliant Graphics Engine

+ External memory up to 32/64/128 MB DDR SGRAM on board

* Dual-view Display Monitor

* TV resolution up 1024x768 32bpp

* CRT resolution up to 2048x1536



St

orage
Bay one interchangeable for 3.5" 3-mode FDD, OR DVD-ROM, OR
CD-ROM, OR CD-RW, OR Combination DVD-ROM/CD-RW drive,
OR secondary battery
Bay two fixed DVD-ROM, OR CD-ROM, OR CD-RW, OR Combina-
tion DVD-ROM/ CD-RW drive
Easy changeable 2.5" 9.5 mm (h) HDD

Supports Master mode IDE

Supports PIO mode 4

ATA-33/66/100

Ultra DMA

Audio

AC'97 2.1 Compliant Interface
3D stereo enhanced sound system
Compatible Sound-Blaster PRO™
S/PDIF Digital output (5.1 CH)
Built in microphone

Audio DJ

Built in 2 speakers 1 watt 36F, 80

S

WinDVD Player Note

WinDVD version 3.1
supports CPU speeds
up to, and including,
2.4GB only.

WIinDVD version
supports  all
speeds.

4.0
CPU

Make sure you are us-
ing the program ver-
sion applicable to your
CPU speed. See

for further details
on CPU speeds.




PC Card

*  One PCMCIA 3.3V/5V sockets, one type II
» Supporting CardBus

Interface

* Built in TouchPad (scroll functionality included)

* Four USB ports (only Model C has USB 2.0 compliant ports - see
“USB Port Type” on page 1 - 7)

* One IEEE 1394 port

* One S-Video jack for TV output

* One parallel port (LPT1), support ECP/EPP

* Infrared file transfer, IrDA 1.1 FIR/SIR/ASKIR

» External CRT monitor

* One PS/2 port support mouse and keyboard (through Y cable)

* One headphone-out jack

* One microphone-in jack

* One S/PDIF out port

e One RJ-11 jack for MDC Modem

* One RJ-45 jack for LAN

* DC-in jack

* Built-in 3 instant keys, www, email, and application



Communication

* Infrared transfer: 115.2K bps SIR/ 4M bps FIR, IrDA 1.1 compliant
* 10/100Mb Ethernet LAN built-in

* 802.11b Wireless LAN mini-PCI interface (option)

* 56K MDC Modem with V.90 & V.92 compliant

Power Management

*  Supports ACPI v1.0b

* Power on suspend

* Supports suspend to RAM

* Supports suspend to disk

» Battery low suspend

*  Modem resume from system suspend
* Resume from LAN ring

* Cover switch




Power (Model A)
For Intel Pentium®4 - 2.0/2.2/2.4GHz Processors ONLY

* Full Range AC adapter
CPUS ds & P
Supplios - Modal A& AC Input 100~240V, 50~60Hz

DC Output 20V, 4.5A, 90W

90W power adapters

RS For Intel Pentium®4 - 1.4/1.5/1.6/1.7/1.8GHz Processors ONLY

supply enough power » Full Range AC adapter
for CPUs below these AC Input 100~240V, 50~60Hz
speeds. DC Output 20V, 6.0A, 120W

For all processors
* Main battery smart Li-Ilon 59W (removable)
» Second battery smart Li-lon 50W (removable)

Power (Model B)
* Full Range AC adapter
AC Input 100~240V, 50~60Hz
DC Output 20V, 4.5A, 90W
* Main battery smart Li-Ion 59W (removable)
» Second battery smart Li-lon 50W (removable)




Power (Model C)
» Full Range AC adapter
AC Input 100~240V, 50~60Hz
DC Output 20V, 6.0A, 120W
* Main battery smart Li-Ion 59W (removable)
* Second battery smart Li-lon 50W (removable)

Indicators

* LED indicator (HDD, Suspend/Power on/ AC-In, Battery Charging/
Battery full, E-mail, Num Lock, Caps Lock, Scroll Lock)
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Environmental Spec

* Temperature Relative Humidity
* Operating: 5°C ~ 35°C Operating: 20% ~ 80%
* Non-Operating: -20°C ~ 60°C Non-Operating: 10% ~ 90%

Physical Dimensions
* 329 (w) x290 (d) x 44(h) mm

Weight

* 3.2 kg without battery (Model A)
* 3.4 kg without battery (Model B)
* 3.7 kg without battery (Model C)

Optional

» Secondary battery pack

e 3.5" 3-mode FDD

* DVD-ROM Drive

e CD-RW Drive

* DVD-ROM and CD-RW Combo Drive
* Software DVD Player

e Wireless LAN module
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